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About this manual

Overview

This manual describes the System 300S SPEED7 CPU 314-2BG03 from
VIPA. Here you may find every information for commissioning and
operation.

Chapter 1: Principles

This Basics contain hints for the usage and information about the project
engineering of a SPEED7 system from VIPA.

General information about the System 300S like dimensions and
environment conditions will also be found.

Chapter 2: Assembly and installation guidelines

In this chapter you will find all information, required for the installation and
the cabling of a process control with the components of the System 300S
with a CPU 314-2BG03.

Chapter 3: Hardware description

Here the hardware components of the CPU 314-2BG03 are more
described. The technical data are at the end of the chapter.

Chapter 4: Deployment CPU 314-2BG03

This chapter describes the employment of a CPU 314-2BG03 with
SPEED?7 technology in the System 300S. The description refers directly to
the CPU and to the employment in connection with peripheral modules that
are mounted on a profile rail together with the CPU at the standard bus.

Chapter 5: Deployment PtP communication

Content of this chapter is the deployment of the RS485 interface for serial
PtP communication. Here you’ll find every information about the protocols,
the activation and project engineering of the interface, which are necessary
for the serial communication using the RS485 interface.

Chapter 6: Deployment PROFIBUS communication

Content of this chapter is the deployment of the CPU 314-2BG03 with
PROFIBUS. After a short overview the project engineering and
parameterization of the PROFIBUS DP slave of the CPU 314-2BG03 from
VIPA is shown. Both the project engineering of the DP slave and the
integration in a DP master system are shown. The chapter is ended with
notes to the PROFIBUS installation guidelines.

Chapter 7: WinPLC7

In this chapter the programming and simulation software WinPLC7 from
VIPA is presented. WIinPLC7 is suited for every with Siemens STEP®7
programmable PLC.

Besides the system presentation and installation here the basics for using
the software is explained with a sample project.

More information concerning the usage of WinPLC7 may be found in the
online help respectively in the online documentation of WinPLC?7.

HB140E - CPU - RE_314-2BG03 - Rev. 12/06 1



About this manual

Manual VIPA System 300S SPEED7

Objective and
contents

Target audience

Structure of the
manual

This manual describes the System 300S SPEED7 CPU 314-2BG03 from
VIPA. It contains a description of the construction, project implementation
and usage.

This manual is part of the documentation package with order number
HB140E_CPU and relevant for:

Product Order number as of state:
CPU-HW CPU-FW
CPU 314SE/DPS |VIPA 314-2BG03 01 V346

The manual is targeted at users who have a background in automation
technology.

The manual consists of chapters. Every chapter provides a self-contained
description of a specific topic.

Guide to the The following guides are available in the manual:
document  an overall table of contents at the beginning of the manual
» an overview of the topics for every chapter
Availability The manual is available in:
» printed form, on paper
* in electronic form as PDF-file (Adobe Acrobat Reader)
Icons Important passages in the text are highlighted by following icons and
Headings headings:
Danger!
Immediate or likely danger.
Personal injury is possible.
Attention!
Damages to property is likely if these warnings are not heeded.
Note!
Supplementary information and useful tips.
2 HB140E - CPU - RE_314-2BG03 - Rev. 12/06




Manual VIPA System 300S SPEED7 Safety information

Safety information

Applications The SPEED7 CPU is constructed and produced for:

conforming with .
specifications .

all VIPA System 300S components
communication and process control
general control and automation applications
industrial applications

operation within the environmental conditions specified in the technical
data

installation into a cubicle

Danger!
This device is not certified for applications in

in explosive environments (EX-zone)

Documentation The manual must be available to all personnel in the

project design department
installation department
commissioning

operation

The following conditions must be met before using or commissioning
the components described in this manual:

Hardware modifications to the process control system should only be
carried out when the system has been disconnected from power!

Installation and hardware modifications only by properly trained
personnel.

The national rules and regulations of the respective country must be
satisfied (installation, safety, EMC ...)

Disposal National rules and regulations apply to the disposal of the unit!

HB140E - CPU - RE_314-2BG03 - Rev. 12/06 3
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Chapter 1 Basics

Overview This Basics contain hints for the usage and information about the project
engineering of a SPEED7 system from VIPA.

General information about the System 300S like dimensions and
environment conditions will also be found.

Content Topic Page
Chapter 1 BaSICS ittt 1-1

Safety Information for USers...........ooooiiiiiiiiice e, 1-2

Operating structure of @ CPU ...........ooiiiiiiiii e 1-3

CPU 314-2BGO3 ...ttt 1-6
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Manual VIPA System 300S SPEED7

Safety Information for Users

Handling of
electrostatic
sensitive modules

Shipping of
electrostatic
sensitive modules

Measurements and
alterations on
electrostatic
sensitive modules

VIPA modules make use of highly integrated components in MOS-
Technology. These components are extremely sensitive to over-voltages
that can occur during electrostatic discharges.

The following symbol is attached to modules that can be destroyed by
electrostatic discharges.

The Symbol is located on the module, the module rack or on packing
material and it indicates the presence of electrostatic sensitive equipment.

It is possible that electrostatic sensitive equipment is destroyed by energies
and voltages that are far less than the human threshold of perception.
These voltages can occur where persons do not discharge themselves
before handling electrostatic sensitive modules and they can damage
components thereby, causing the module to become inoperable or
unusable.

Modules that have been damaged by electrostatic discharges can fail after
a temperature change, mechanical shock or changes in the electrical load.

Only the consequent implementation of protection devices and meticulous
attention to the applicable rules and regulations for handling the respective
equipment can prevent failures of electrostatic sensitive modules.

Modules must be shipped in the original packing material.

When you are conducting measurements on electrostatic sensitive
modules you should take the following precautions:

* Floating instruments must be discharged before use.
* Instruments must be grounded.

Modifying electrostatic sensitive modules you should only use soldering
irons with grounded tips.

Attention!

Personnel and instruments should be grounded when working on
electrostatic sensitive modules.

1-2
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Operating structure of a CPU

General

Cyclic processing

Timer processing

Alarm controlled
processing

Priority based
processing

The CPU contains a standard processor with internal program memory. In
combination with the integrated SPEED7 technology the unit provides a
powerful solution for process automation applications within the System
300S family.

A CPU supports the following modes of operation:

» cyclic operation

» timer processing

» alarm controlled operation
» priority based processing

Cyclic processing represents the major portion of all the processes that
are executed in the CPU. Identical sequences of operations are repeated in
a never-ending cycle.

Where a process requires control signals at constant intervals you can
initiate certain operations based upon a timer, e.g. not critical monitoring
functions at one-second intervals.

If a process signal requires a quick response you would allocate this signal
to an alarm controlled procedure. An alarm can activate a procedure in
your program.

The above processes are handled by the CPU in accordance with their
priority. Since a timer or an alarm event requires a quick reaction, the
CPU will interrupt the cyclic processing when these high-priority events
occur to react to the event. Cyclic processing will resume, once the
reaction has been processed. This means that cyclic processing has the
lowest priority.

HB140E - CPU - RE_314-2BG03 - Rev. 12/06 1-3
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Manual VIPA System 300S SPEED7

Applications

System routine

User application

Operands

Process image
and periphery

The program that is present in every CPU is divided as follows:
» System routine
» User application

The system routine organizes all those functions and procedures of the
CPU that are not related to a specific control application.

This consists of all the functions that are required for the processing of a
specific control application. The operating modules provide the interfaces
to the system routines.

The following series of operands is available for programming the CPU:
* Process image and periphery

* Bit memory

» Timers and counters

» Data blocks

The user application can quickly access the process image of the inputs
and outputs PAA/PAE. You may manipulate the following types of data:

 individual Bits
* Bytes

« Words

* Double words

You may also gain direct access to peripheral modules via the bus from
user application. The following types of data are available:

* Bytes
« Words
* Blocks

1-4
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Bit Memory The bit memory is an area of memory that is accessible by means of
certain operations. Bit memory is intended to store frequently used working
data.

You may access the following types of data:
* individual Bits

* Bytes

* Words

* Double words

Timers and In your program you may load cells of the timer with a value between 10ms

counters and 9990s. As soon as the user application executes a start-operation, the
value of this timer is decremented by the interval that you have specified
until it reaches zero.

You may load counter cells with an initial value (max. 999) and increment
or decrement these when required.

Data Blocks A data block contains constants or variables in the form of bytes, words or
double words. You may always access the current data block by means of
operands.

You may access the following types of data:
* individual Bits

* Bytes

* Words

* Double words

HB140E - CPU - RE_314-2BG03 - Rev. 12/06 1-5
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CPU 314-2BG03

Overview

Access options

The CPU 314-2BGO03 bases upon the SPEED7 technology. This supports
the CPU at programming and communication by means of co-processors
that causes a power improvement for highest needs.

The SPEED7 CPUs from VIPA are instruction compatible to the
programming language STEP®7 from Siemens and may be programmed
via WinPLC7 from VIPA or via the Siemens SIMATIC Manager. Here the
instruction set of the S7-400 from Siemens is used.

Modules and CPUs of the System 300S from VIPA and Siemens may be
used at the "Standard" bus as a mixed configuration.

The user application is stored in the battery buffered RAM or on an
additionally pluggable MMC storage module.

The CPU is configured as CPU 315-2AG10 (6ES7 315-2AG10-0AB0/V2.6)
from Siemens.

RS232

WinPLC7 from VIPA
SIMATIC Manager

from Siemens

—‘ RJ45

CPU
DP-Slave
X2 X3
MPI Adapter > CPU
@ ‘t RN
. o Proj. ’
W+ PG/OP
| Proj.
_’ ay | Overall Reset Tip Web
6}’;‘; @ lBSec. @ l
il

| Mcc

(

Ethernet

Note!

Please always use the CPU 315-2AG10 (6ES7 315-2AG10-0AB0/V2.6)
from Siemens of the hardware catalog to project this CPU from VIPA.

For the project engineering, a thorough knowledge of the Siemens
SIMATIC Manager and the hardware configurator from Siemens is
required!

1-6
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Memory
management

Integrated
PROFIBUS DP
slave

PtP
communication

Integrated
Ethernet PG/OP
channel

Operation Security

Environmental
conditions

Dimensions/
Weight

Integrated
power supply

The CPU has an integrated memory. Information about the capacity
(min. capacity ... max capacity) of the memory may be found at the front of
the CPU.

The memory is divided into the following 3 parts:
* Load memory 512kbyte

» Code memory (50% of the work memory)

» Data memory (50% of the work memory)

The work memory has128kbyte. There is the possibility to extend the work
memory to its maximum printed capacity 512kbyte by means of a MCC
memory extension card.

The CPU has a PROFIBUS DP slave integrated. This is configured during
hardware configuration by the PROFIBUS part of the CPU 315-2AG10
(6ES7 315-2AG10-0AB0/V2.6) from Siemens. Here switch during
configuration the PROFIBUS part to "Slave" operation mode.

By switching the PROFIBUS part to "Master" operation without linking, the
interface may be used for point-to-point (PtP) communication. Here the
communication happens by means of VIPA handling blocks.

The CPU has an Ethernet interface for PG/OP communication. Via the
"PLC" functions you may directly access the Ethernet PG/OP channel and
program res. remote control your CPU. A max. of 4 PG/OP connections is
available.

You may also access the CPU with a visualization software via these
connections.

» Wiring by means of spring pressure connections (CageClamps) at the
front connector

« Core cross-section 0.08...2.5mm?

» Total isolation of the wiring at module change

» Potential separation of all modules to the backplane bus

» ESD/Burst acc. IEC 61000-4-2/IEC 61000-4-4 (up to level 3)

» Shock resistance acc. IEC 60068-2-6 / IEC 60068-2-27 (1G/12G)

» Operating temperature: 0 ... +60°C

» Storage temperature: -25 ... +70°C

* Relative humidity: 5 ... 95% without condensation
» Ventilation by means of a fan is not required

+ Dimensions of the basic enclosure: 1tier width:
(HXWxD) in mm: 40x125x120

The CPU comes with an integrated power supply. The power supply has to
be supplied with DC 24V. By means of the supply voltage, the internal
electronic is supplied as well as the connected modules via backplane bus.
The power supply is protected against inverse polarity and overcurrent.

HB140E - CPU - RE_314-2BG03 - Rev. 12/06 1-7
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Chapter 2 Assembly and installation guidelines

Overview In this chapter you will find all information, required for the installation and
the cabling of a process control with the components of a CPU 314-2BG03
in the System 300S.

Content Topic Page
Chapter 2 Assembly and installation guidelines..........cccccccceeee.. 2-1

Installation diMeNSIONS ... ..cooi i 2-2

Assembly standard bus ..o 2-3

CabliNG . 2-5

Installation guUIdelingS .........ccooiiiiiiiice e 2-6
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Installation dimensions

Dimensions
Basic enclosure

1tier width (WxHxD) in mm: 40 x 125 x 120

Dimensions 1
€
5
€
£
1S
&
1
Installation «~ 125mm —————
dimensions 120mm
i
5 |
p——
175mm
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Assembly standard bus

General

Profile rail

Bus connector

The single modules are directly installed on a profile rail and connected via
the backplane bus connector. Before installing the modules you have to
clip the backplane bus connector to the module from the backside.

The backplane bus connector is delivered together with the peripheral
modules.

Order number A B C
VIPA 390-1AB60 160 140 10
VIPA 390-1AE80 482 466 8.3
VIPA 390-1AF30 530 500 15
VIPA 390-1AJ30 830 800 15
VIPA 390-9BC00* 2000 Drillings only left 15

* Unit pack: 10 pieces
Measures in mm

A
< >
325 [/ E
° 14
57.2| | g™° 10| B 122
O %27
/// |
/ | ,i
5 »15
—» C < >

For the communication between the modules the System 300S uses a
backplane bus connector. Backplane bus connectors are included in the
delivering of the peripheral modules and are clipped at the module from the
backside before installing it to the profile rail.

HB140E - CPU - RE_314-2BG03 - Rev. 12/06 2-3
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Assembly
possibilities
horizontal assembly Verticf)'l Please regard the allowed environment temperatures:
assembly
5! 5 5 o * horizontal assembly: from 0 to 60°C
° |° * vertical assembly: from 0 to 40°C
= | | » lying assembly: from 0 to 40°C
lying assembly — @
0 @ O
’: :‘
Approach
. » Bolt the profile rail with the background (screw size: M6),
so that you still have minimum 65mm space above and
4 40mm below the profile rail.
4 » If the background is a grounded metal or device plate,

Danger!

please look for a low-impedance connection between
profile rail and background.

Connect the profile rail with the protected earth conductor.
For this purpose there is a bolt with M6-thread.

The minimum cross-section of the cable to the protected
earth conductor has to be 10mm?

Stick the power supply to the profile rail and pull it to the
left side to the grounding bolt of the profile rail.

Fix the power supply by screwing.

Take a backplane bus connector and click it at the CPU
from the backside like shown in the picture.

Stick the CPU to the profile rail right from the power supply
and pull it to the power supply.

Click the CPU downwards and bolt it like shown.

Repeat this procedure with the peripheral modules, by
clicking a backplane bus connector, stick the module right
from the modules you've already fixed, click it downwards
and connect it with the backplane bus connector of the last
module and bolt it.

» The power supplies must be released before installation and repair
tasks, i.e. before handling with the power supply or with the cabling you
must disconnect current/voltage (pull plug, at fixed connection switch off
the concerning fuse)!

» Installation and modifications only by properly trained personnel!

2-4
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Cabling

CageClamp
technology (green)

<

Danger!

» The power supplies must be released before installation and repair
tasks, i.e. before handling with the power supply or with the cabling you
must disconnect current/voltage (pull plug, at fixed connection switch off
the concerning fuse)!

» Installation and modifications only by properly trained personnel!

For the cabling of power supply of a CPU, a green plug with CageClamp
technology is deployed.

The connection clamp is realized as plug that may be clipped off carefully if
it is still cabled.

Here wires with a cross-section of 0.08mm? to 2.5mm? may be connected.
You can use flexible wires without end case as well as stiff wires.

..E 6 [1]  Test point for 2mm test tip
‘ u_ 57 1 [2] Locking (orange) for screwdriver
L > [3] Round opening for wires
3

The picture on the left side shows the cabling step by step from top view.

¢ For cabling you push the locking vertical to the inside with a suiting
screwdriver and hold the screwdriver in this position.

* Insert the de-isolated wire into the round opening. You may use wires
with a cross-section from 0.08mm? to 2.5mm?>.

« By removing the screwdriver the wire is connected safely with the plug
connector via a spring.

HB140E - CPU - RE_314-2BG03 - Rev. 12/06 2-5
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Installation guidelines

General

What means
EMC?

Possible
interference
causes

The installation guidelines contain information about the interference free
deployment of System 300S systems. There is the description of the ways,
interference may occur in your control, how you can make sure the
electromagnetic digestibility (EMC), and how you manage the isolation.

Electromagnetic digestibility (EMC) means the ability of an electrical
device, to function error free in an electromagnetic environment without
being interferenced res. without interferencing the environment.

All System 300S components are developed for the deployment in hard
industrial environments and fulfill high demands on the EMC. Nevertheless
you should project an EMC planning before installing the components and
take conceivable interference causes into account.

Electromagnetic interferences may interfere your control via different ways:
* Fields

* |/O signal conductors

* Bus system

» Current supply

* Protected earth conductor

Depending on the spreading medium (lead bound or lead free) and the
distance to the interference cause, interferences to your control occur by
means of different coupling mechanisms.

One differs:

» galvanic coupling

» capacitive coupling
* inductive coupling
 radiant coupling

2-6
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Basic rules for In the most times it is enough to take care of some elementary rules to
EMC guarantee the EMC. Please regard the following basic rules when installing
your PLC.

Take care of a correct area-wide grounding of the inactive metal parts
when installing your components.

- Install a central connection between the ground and the protected
earth conductor system.

- Connect all inactive metal extensive and impedance-low.

- Please try not to use aluminum parts. Aluminum is easily oxidizing
and is therefore less suitable for grounding.

When cabling, take care of the correct line routing.

- Organize your cabling in line groups (high voltage, current supply,
signal and data lines).

- Always lay your high voltage lines and signal res. data lines in
separate channels or bundles.

- Route the signal and data lines as near as possible beside ground
areas (e.g. suspension bars, metal rails, tin cabinet).

Proof the correct fixing of the lead isolation.
Data lines must be laid isolated.

Analog lines must be laid isolated. When transmitting signals with
small amplitudes the one sided laying of the isolation may be
favorable.

Lay the line isolation extensively on an isolation/protected earth con-
ductor rail directly after the cabinet entry and fix the isolation with
cable clamps.

- Make sure that the isolation/protected earth conductor rail is
connected impedance-low with the cabinet.

- Use metallic or metalized plug cases for isolated data lines.
In special use cases you should appoint special EMC actions.

- Wire all inductivities with erase links.

- Please consider luminescent lamps can influence signal lines.

Create a homogeneous reference potential and ground all electrical
operating supplies when possible.

- Please take care for the targeted employment of the grounding
actions. The grounding of the PLC is a protection and functionality
activity.

- Connect installation parts and cabinets with the System 300S in star
topology with the isolation/protected earth conductor system. So you
avoid ground loops.

- If potential differences between installation parts and cabinets occur,
lay sufficiently dimensioned potential compensation lines.

HB140E - CPU - RE_314-2BG03 - Rev. 12/06 2-7
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Isolation of
conductors

Electrical, magnetically and electromagnetic interference fields are
weakened by means of an isolation, one talks of absorption.

Via the isolation rail, that is connected conductive with the rack,
interference currents are shunt via cable isolation to the ground. Hereby
you have to make sure, that the connection to the protected earth conduc-
tor is impedance-low, because otherwise the interference currents may
appear as interference cause.

When isolating cables you have to regard the following:
» If possible, use only cables with isolation tangle.
» The hiding power of the isolation should be higher than 80%.

* Normally you should always lay the isolation of cables on both sides.
Only by means of the both-sided connection of the isolation you achieve
high quality interference suppression in the higher frequency area.

Only as exception you may also lay the isolation one-sided. Then you
only achieve the absorption of the lower frequencies. A one-sided
isolation connection may be convenient, if:

- the conduction of a potential compensating line is not possible
- analog signals (some mV res. pyA) are transferred
- foil isolations (static isolations) are used.

* With data lines always use metallic or metalized plugs for serial
couplings. Fix the isolation of the data line at the plug rack. Do not lay
the isolation on the PIN 1 of the plug bar!

* At stationary operation it is convenient to strip the insulated cable
interruption free and lay it on the isolation/protected earth conductor line.

» To fix the isolation tangles use cable clamps out of metal. The clamps
must clasp the isolation extensively and have well contact.

» Lay the isolation on an isolation rail directly after the entry of the cable in
the cabinet. Lead the isolation further on to the System 300S module
and don't lay it on there again!

Please regard at installation!

At potential differences between the grounding points, there may be a
compensation current via the isolation connected at both sides.

Remedy: Potential compensation line

2-8
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Chapter 3 Hardware description

Overview Here the hardware components of the CPU 314-2BG03 are more
described. The technical data are at the end of the chapter.
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Properties

CPU 314SE/DPS

314-2BG03

Ordering data

SPEED?Y technology integrated

128kbyte integrated work memory (64kbyte code, 64kbyte data)
Memory expandable to max. 512kbyte (256kbyte code, 256kbyte data)
Load memory 512kbyte

PROFIBUS DP slave integrated (DP-VO, DP-V1)

MPI interface

MCC slot for external memory cards and memory extension

Status LEDs for operating state and diagnosis

Real-time clock battery buffered

Ethernet PG/OP channel

RS485 interface configurable for PROFIBUS DP slave respectively
PtP communication

I/O address range digital/analog 2048byte
512 timer

512 counter
8192 flag byte

UIPA cru3isse

PWR

S

RUN
STOP
MRES

VIPA 314-2BG03 x|z
128/512KByte TL_

JNT &

Type

Order number | Description

314SE/DPS

VIPA 314-2BGO03 | MPI interface, card slot, real time clock, Ethernet interface for

PG/OP, PROFIBUS DP slave

3-2
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Structure

CPU 314SE/DPS

—— 2

314-2BG03
UIPH CPU314 SE|

[CJPWR
| |RUN
| |sTOP
|SF
|_|FRCE
[ Mcc = mce
A
s

128/512KByte

RUN
I‘% STOP
MRES

VIPA314-28G03 -

—— 4

o
o[
X1
O
X2 X30
MPI PBDP/PtP

Schnittstellen

X3
PtP/PB-DP

O Q &;) @

=

0'0'0°00

®

OICIOIOIOICKOIOXS)

@EOEROOEOE

+DC24V
ov

n.c.
M24V

RxD/TxD-P (line B)
RTS

M5V

P5V

P24v

RxD/TxD-N (line A)
n.c.

shield

M24V

RxD/TxD-P (line B)
RTS

M5V

P5V

P24V

RxD/TxD-N (line A)
n.c.

[1]
[2]
[3]
[4]

LEDs (deactivated)

Storage media slot

LEDs of the CPU part
Operating mode switch CPU

The following components
are under the front flap

[5]
[6]

[7]
[8]

55555555

Slot for DC 24V power supply

Twisted pair interface
for Ethernet PG/OP channel

MPI interface
PROFIBUS DP/PtP interface

(» Transmit +
@ Transmit -
(® Receive +
® n.c.
n.c.
5 Receive -

@@

.C.
. C.

n
n

@Q
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Power supply
X1

MPI interface
X2

Ethernet PG/OP
channel
X4

The CPU has an integrated power supply. The power supply has to be
provided with DC 24V. For this serves the double DC 24V slot, that is
underneath the flap.

Via the power supply not only the internal electronic is provided with
voltage, but by means of the backplane bus also the connected modules.
The power supply is protected against polarity inversion and overcurrent.
The internal electronic is galvanically connected with the supply voltage.

9-pin SubD jack:
The MPI interface serves for the connection between programming unit
and CPU. By means of this the project engineering and programming

happens. In addition MPI serves for communication between several CPUs
or between HMIs and CPU.

Standard setting is MPI Address 2.

8pin RJ45 jack:

The RJ45 jack serves the interface to the Ethernet PG/OP channel. This
interface allows you to program res. remote control your CPU, to access
the internal website or to connect a visualization. Configurable connections
are not possible.

For online access to the CPU via Ethernet PG/OP channel valid IP address
parameters have to be assigned to this. More may be found at chapter
"Deployment CPU ..." at "Initialization Ethernet PG/OP channel".

3-4
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Memory RS485
interface with
configurable
functionality
X3

PtP functionality

PROFIBUS-
Functionality

deactivated

RS485 interface

Memory
management

The CPU has an integrated RS485 interface. The functionality of this
interface may be configured during hardware configuration by setting the
operating mode of the PROFIBUS part of the Siemens CPU (315-2AG10-
0ABOO V2.6).

Here the following functionalities may be set:

Per default the RS485 interface is preset to PtP functionality without any
protocol.

Using the PtP functionality the RS485 interface is allowed to connect via
serial point-to-point connection to different source respective target
systems. Here the protocols ASCIIl, STX/ETX, 3964R, USS and Modbus-
Master (ASCIl, RTU) are supported. Configuration and communication
happens during runtime.

To activate the PtP functionality set the PROFIBUS part to "Master"
operation without linking.

With PROFIBUS functionality the integrated PROFIBUS DP slave is
connected to PROFIBUS via the RS485 interface.

To activate the PROFIBUS functionality set the PROFIBUS part to "Slave"
operation.

To deactivate the interface set the PROFIBUS part to "Master" operation
with linking.

Independently of functionality the RS485 interface have the same pin
assignment.

The CPU has an integrated memory. Information about the capacity
(min. capacity ... max capacity) of the memory may be found at the front of
the CPU.

The memory is divided into the following 3 parts:
* Load memory 512kbyte

» Code memory (50% of the work memory)

» Data memory (50% of the work memory)

The work memory has 128kbyte. There is the possibility to extend the work
memory to its maximum printed capacity 512kbyte by means of a MCC
memory extension card.
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Operating mode
switch

RUN
(D) swr
MRES

Storage
media slot

With the operating mode switch you may switch the CPU between STOP
and RUN.

During the transition from STOP to RUN the operating mode START-UP is
driven by the CPU.

Placing the switch to MRES (Memory Reset), you request an overall reset
with following load from MMC, if a project there exists.

As external storage medium for applications and firmware you may use a
MMC storage module (Multimedia card) or a MCC memory extension card.
The MCC can additionally be used as an external storage medium.

Both VIPA storage media are pre-formatted with the PC format FAT16 and
can be accessed via a card reader. An access to the storage media always
happens after an overall reset and PowerON.

After PowerON respectively an overall reset the CPU checks, if there is a
storage medium with data valid for the CPU.

3-6

HB140E - CPU - RE_314-2BG03 - Rev. 12/06



Manual VIPA System 300S SPEED7

Chapter 3 Hardware description

LEDs The CPU has got LEDs on its front side. In the following the usage and the
according colors of the LEDs is described.
LEDs CPU As soon as the CPU is supplied with 5V, the green PWR-LED is on.
RUN | STOP SF FRCE | MCC |Meaning
green | yellow red yellow | yellow
Boot-up after PowerON
() {:E* () ) () * Blinking with 10Hz: Firmware is loaded.
® ® o () [ Initialization: Phase 1
® ® () o 0] Initialization: Phase 2
® ® o @) @) Initialization: Phase 3
@] ® () O 0] Initialization: Phase 4
Operation
@) [ ) X X X CPU is in STOP state.
ij} o CPU is in start-up state, the RUN LED blinks during operating
X X X 0OB100 at least for 3s.
o @) @) X X CPU is in state RUN without error.
There is a system fault. More information may be found in the
X X o X X diagnostics buffer of the CPU.
X X X [ ) X Variables are forced.
X X X X ) Access to the memory card.
Overall reset
O %:1— X X X | Overall reset is requested.
@) {t%* X X X | Blinking with 5Hz: Overall reset is executed.
Factory reset
® ] O O @) Factory reset is executed.
O () o ) o Factory reset finished without error.
Firmware update
The alternate blinking indicates that there is new firmware on
® ﬁ {:} o the memory card.
The alternate blinking indicates that a firmware update is
© © ﬁ {:} executed.
O () o ) o Firmware update finished without error.
©) {:E* {:}* {:E* {:}* * Blinking with 10Hz: Error during Firmware update.
on: ® off: O blinking (2Hz): ij} not relevant: X

LEDs Ethernet
PG/OP channel

A 'S

The green A-LED (Activity) indicates the physical connection of the
Ethernet PG/OP channel to Ethernet. Irregular flashing of the A-LED
indicates communication of the Ethernet PG/OP channel via Ethernet.

If the green S-LED (Speed) is on, the Ethernet PG/OP has a
communication speed of 100MBit/s otherwise with 10MBit/s.

HB140E - CPU - RE_314-2BG03 - Rev. 12/06

3-7



Chapter 3 Hardware description Manual VIPA System 300S SPEED7

Technical Data

Order number 314-2BG03
Type CPU 314SE/DPS
SPEED-Bus -

Technical data power supply

Power supply (rated value) DC 24V

Power supply (permitted range) DC 20.4...28.8V
Reverse polarity protection v

Current consumption (no-load operation) 180 mA

Current consumption (rated value) 900 mA

Inrush current 8A

Max. current drain at backplane bus 3A

Load and working memory

Load memory, integrated 512 KB

Load memory, maximum 512 KB

Work memory, integrated 128 KB

Work memory, maximal 512 KB

Memory divided in 50% program / 50% data v

Memory card slot MMC-Card with max. 1 GB
Hardware configuration

Racks, max. 4

Modules per rack, max. 8 in multiple-, 32 in a single-

rack configuration

Number of integrated DP master

Number of DP master via CP 4
Operable function modules 8
Operable communication modules PtP 8
Operable communication modules LAN 8
Status information, alarms, diagnostics

Status display yes
Interrupts no
Process alarm no
Diagnostic interrupt no
Command processing times

Bit instructions, min. 0.02 us
Word instruction, min. 0.02 us
Double integer arithmetic, min. 0.02 us
Floating-point arithmetic, min. 0.12 ys
Timers/Counters and their retentive

characteristics

Number of S7 counters 512
Number of S7 times 512
Data range and retentive characteristic

Number of flags 8192 Byte
Number of data blocks 4095
Max. data blocks size 64 KB
Max. local data size per execution level 510 Byte
Blocks

Number of OBs 15
Number of FBs 2048
Number of FCs 2048
Maximum nesting depth per priority class 8
Maximum nesting depth additional within an error |4

OB

Time
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Real-time clock buffered v

Clock buffered period (min.) 6W
Accuracy (max. deviation per day) 10s
Number of operating hours counter 8

Clock synchronization v
Synchronization via MPI Master/Slave
Synchronization via Ethernet (NTP) no
Address areas (1/0O)

Input I/O address area 2048 Byte
Output I/O address area 2048 Byte
Input process image maximal 128 Byte
Output process image maximal 128 Byte
Digital inputs 16384
Digital outputs 16385
Digital inputs central 1024
Digital outputs central 1024
Integrated digital inputs -
Integrated digital outputs -

Analog inputs 1024
Analog outputs 1024
Analog inputs, central 256
Analog outputs, central 256

Integrated analog inputs

Integrated analog outputs

Communication functions

PG/OP channel

Global data communication

Number of GD circuits, max.

Size of GD packets, max.

S7 basic communication

S7 basic communication, user data per job

S7 communication

NNERNERER
[v9) [v9)
S| =
D (0]

S7 communication as server

S7 communication as client

S7 communication, user data per job 160 Byte
Number of connections, max. 32
Functionality Sub-D interfaces

Type X2

Type of interface RS485
Connector Sub-D, 9-pin, female
Electrically isolated -

MPI v

MP?l (MPI/RS232) -

DP master -

DP slave -
Point-to-point interface -

Type X3

Type of interface RS485
Connector Sub-D, 9-pin, female
Electrically isolated v

MPI -

MP?l (MPI/RS232) -

DP master -

DP slave v
Point-to-point interface v

CAN -

HB140E - CPU - RE_314-2BG03 - Rev. 12/06
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Order number

314-2BG03

Functionality PROFIBUS master

PG/OP channel

Routing

S7 basic communication

S7 communication

S7 communication as server

S7 communication as client

Equidistance support

Isochronous mode

SYNC/FREEZE

Activation/deactivation of DP slaves

Direct data exchange (slave-to-slave
communication)

DPV1

Transmission speed, min.

Transmission speed, max.

Number of DP slaves, max.

Address range inputs, max.

Address range outputs, max.

User data inputs per slave, max.

User data outputs per slave, max.

Functionality PROFIBUS slave

PG/OP channel

Routing

S7 communication

S7 communication as server

S7 communication as client

Direct data exchange (slave-to-slave
communication)

DPV1

Transmission speed, min.

9.6 kbit/s

Transmission speed, max.

12 Mbit/s

Automatic detection of transmission speed

Transfer memory inputs, max.

244 Byte

Transfer memory outputs, max.

244 Byte

Address areas, max.

32

User data per address area, max.

32 Byte

Point-to-point communication

PtP communication

Interface isolated

RS232 interface

RS422 interface

RS485 interface

Connector

Sub-D, 9-pin, female

Transmission speed, min.

150 bit/s

Transmission speed, max.

115.5 kbit/s

Cable length, max.

500 m

Point-to-point protocol

ASCII protocol

STX/ETX protocol

3964(R) protocol

SRR

RK512 protocol

USS master protocol

Modbus master protocol

ANRNE

Modbus slave protocol

Special protocols

Functionality RJ45 interfaces

3-10
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Order number 314-2BG03

Type X4

Type of interface Ethernet 10/100 MBit
Connector RJ45

Electrically isolated v

PG/OP channel v

Productive connections -

Mechanical data

Dimensions (WxHxD) 40 x 125 x 120 mm
Weight 2359
Environmental conditions

Operating temperature 0°Cto60°C
Storage temperature -25°Cto 70 °C
Certifications

UL508 certification in preparation
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Chapter 4 Deployment CPU 314-2BG03

Overview This chapter describes the employment of a 314-2BG03 with SPEED7
technology in the System 300S. The description refers directly to the CPU
and to the employment in connection with peripheral modules that are
mounted on a profile rail together with the CPU at the standard bus.
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Assembly

Note!

Information about assembly and cabling may be found at chapter
"Assembly and installation guidelines"

Start-up behavior

Turn on power
supply

Default boot
procedure, as
delivered

Boot procedure with
valid data in the CPU

Boot procedure
with empty battery

After the power supply has been switched on, the CPU changes to the
operating mode the operating mode lever shows.

When the CPU is delivered it has been reset.
After a STOP - RUN transition the CPU switches to RUN without program.

The CPU switches to RUN with the program stored in the battery buffered
RAM.

The accumulator/battery is automatically loaded via the integrated power
supply and guarantees a buffer for max. 30 days. If this time is exceeded,
the battery may be totally discharged. This means that the battery buffered
RAM is deleted.

In this state, the CPU executes an overall reset. If a MMC is plugged,
program code and data blocks are transferred from the MMC into the work
memory of the CPU.

If no MMC is plugged, the CPU transfers permanent stored "protected"
blocks into the work memory if available.

Information about storing protected blocks in the CPU is to find in this
chapter at "Extended Know-how protection".

Depending on the position of the operating mode switch, the CPU switches
to RUN res. remains in STOP.

This event is stored in the diagnostic buffer as: "Start overall reset
automatically (unbuffered PowerON)".

4-2
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Addressing

Overview

Addressing
Backplane bus
I/O devices

Max. number of
pluggable
modules

Define addresses
by hardware
configuration

To provide specific addressing of the installed peripheral modules, certain
addresses must be allocated in the CPU.

At the start-up of the CPU, this assigns automatically peripheral addresses
for digital in-/output modules starting with 0 and ascending depending on the
slot location.

If no hardware project engineering is available, the CPU stores at the
addressing analog modules to even addresses starting with 256.

The CPU 314-2BGO03 provides an I/O area (address 0 ... 2048) and a
process image of the in- and outputs (each address 0 ... 127).

The process image stores the signal states of the lower address (0 ... 127)
additionally in a separate memory area.

The process image this divided into two parts:
» process image to the inputs (PIl)
» process image to the outputs (PIQ)

I/O area Process image
0 0
—_— : Inputs
. Pl
. 127
127 0
Outputs
_ _ PIQ
2048 127

The process image is updated automatically when a cycle has been
completed.

Maximally 8 modules per row may be configured by the CPU314-2BGO03.

For the project engineering of more than 8 modules you may use line
interface connections. For this you set in the hardware configurator the
module IM 360 from the hardware catalog to slot 3 of your 1. profile rail.
Now you may extend your system with up to 3 profile rails by starting each
with an IM 361 from Siemens at slot 3. Considering the max total current
with the CPU 314-2BG03 from VIPA up to 32 modules may be arranged in
a row. Here the installation of the line connections IM 360/361 from
Siemens is not required.

You may access the modules with read res. write accesses to the
peripheral bytes or the process image.

To define addresses a hardware configuration may be used. For this, click
on the properties of the according module and set the wanted address.
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Automatic If you do not like to use a hardware configuration, an automatic addressing
addressing comes into force.
At the automatic address allocation DIOs occupy depending on the slot
location always 4byte and AlOs, FMs, CPs always 16byte at the bus.
Depending on the slot location the start address from where on the
according module is stored in the address range is calculated with the
following formulas:
DIOs: Start address = 4[(slot -1)
AlOs, FMs, CPs: Start address = 16[(slot -1)+256
Slot number 1,2, .. —’
4 5 6 7
Start
address
digital: 0 4 8 12
analog: CPU 256 272 288 304
Example for The following sample shows the functionality of the automatic address
automatic address allocation:
allocation
Slot number: 4 5 6 7 8
> 2| L Bus
OmmEimm Qum Sum D
la) ~ Q X o
S| x| €] 2| 3
= © (@) (@] (@)
cru| O < a ) <
A
PII Address Periphery area Periphery area Address PIQ
0 Input Byte 0
1 Input Byte - T Output Byte 8
N Output Byte 9 >
12 Input Byte ::’7 ——
——— Output Byte 12
up to max. 127 13 Input Byte . up to max. 127

—»

digital

<«
analog

i
I

2048

Input Byte

Input Byte

Output Byte

Output Byte

13

6

3

2048

digital

25
Output Byte 320
35

analog

« >
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Hardware configuration - CPU

Requirements

Proceeding

The hardware configuration of the VIPA CPU 314-2BG03 takes place at
the Siemens hardware configurator.

The hardware configurator is a part of the Siemens SIMATIC Manager. It
serves the project engineering. The modules, which may be configured
here are listed in the hardware catalog. If necessary you have to update
the hardware catalog with Options > Update Catalog.

For project engineering a thorough knowledge of the Siemens SIMATIC
manager and the Siemens hardware configurator are required!

Note!

Please consider that this SPEED7-CPU has 4 ACCUs. After an arithmetic
operation (+I, -, *I, /I, +D, -D, *D, /D, MOD, +R, -R, *R, /R) the content of
ACCU 3 and ACCU 4 is loaded into ACCU 3 and 2.

This may cause conflicts in applications that presume an unmodified
ACCU2.

For more information may be found in the manual "VIPA Operation list
SPEED7" at "Differences between SPEED7 and 300V programming".

To be compatible with the Siemens SIMATIC manager the following steps
should be executed:

« Start the Siemens hardware configurator with a new project.

Steckpl.

Modul

» Insert a profile rail from the hardware catalog.

1

2
X2

CPU 315-2DP

« Place at slot 2 the following CPU from Siemens:

DP

CPU 315-2AG10 (6ES7 315-2AG10-0AB0/V2.6).

3

» Configure the integrated PROFIBUS DP slave by means of the
PROFIBUS part of the Siemens CPU 315-2AG10 switched to
"Slave" operation mode. More may be found at chapter "Deployment
PROFIBUS communication".
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Hardware configuration - /O modules

Hardware
configuration of
the modules

Parameterization

Parameterization
during runtime

Bus extension
with IM 360 and
IM 361

After the hardware configuration place the System 300 modules in the
plugged sequence starting with slot 4.

H H Slot | Module |
D)

1 Parameter DIO

X.. [CPU_

DI DO DIO Al AO Para

DI
DO ’
DIO””
Al

AO

O |00 N[O |01 [~ |

[ Y
= o

For parameterization double-click during the project engineering at the slot
overview on the module you want to parameterize In the appearing dialog
window you may set the wanted parameters.

By using the SFCs 55, 56 and 57 you may alter and transfer parameters
for wanted modules during runtime.

For this you have to store the module specific parameters in so called
"record sets".

More detailed information about the structure of the record sets is to find in
the according module description.

For the project engineering of more than 8 modules you may use line
interface connections. For this you set in the hardware configurator the
module IM 360 from the hardware catalog to slot 3 of your 1. profile rail.
Now you may extend your system with up to 3 profile rails by starting each
with an IM 361 from Siemens at slot 3. Considering the max total current
with the VIPA SPEED7 CPUs up to 32 modules may be arranged in a row.

Here the installation of the line connections IM 360/361 from Siemens is
not required.
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Hardware configuration - Ethernet PG/OP channel

Overview

Assembly and
commissioning

"Initialization" via
PLC functions

The CPU 314-2BG03 has an integrated Ethernet PG/OP channel. This
channel allows you to program and remote control your CPU.

The PG/OP channel also gives you access to the internal web page that
contains information about firmware version, connected |/O devices,
current cycle times etc.

With the first start-up respectively after an overall reset the Ethernet
PG/OP channel does not have any IP address.

For online access to the CPU via Ethernet PG/OP channel valid IP address
parameters have to be assigned to this by means of the Siemens SIMATIC
manager. This is called "initialization".

* Install your System 300S with your CPU.

* Wire the system by connecting cables for voltage supply and signals.
» Connect the Ethernet jack of the Ethernet PG/OP channel to Ethernet
» Switch on the power supply.

- After a short boot time the CP is ready for communication.
He possibly has no IP address data and requires an initialization.

The initialization via PLC functions takes place with the following

proceeding:

» Determine the current Ethernet (MAC) address of your Ethernet PG/OP
channel. This always may be found as 1. address under the front flap of
the CPU on a sticker on the left side.

L

Ethernet address
Ethernet PG/OP
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Assign IP address
parameters

Take IP address
parameters in
project

You get valid IP address parameters from your system administrator. The
assignment of the IP address data happens online in the Siemens
SIMATIC manager starting with version V 5.3 & SP3 with the following
proceeding:

Start the Siemens SIMATIC manager and set via Options > Set PG/PC
interface the access path to "TCP/IP -> Network card .... ".

Open with PLC > Edit Ethernet Node the dialog window with the same
name.

To get the stations and their MAC address, use the [Browse] button or
type in the MAC Address. The Mac address may be found at the 1. label
beneath the front flap of the CPU.

Choose if necessary the known MAC address of the list of found
stations.

Either type in the IP configuration like IP address, subnet mask and
gateway. Or your station is automatically provided with IP parameters by
means of a DHCP server. Depending of the chosen option the DHCP
server is to be supplied with MAC address, equipment name or client ID.
The client ID is a numerical order of max. 63 characters. The following
characters are allowed: "hyphen", 0-9, a-z, A-Z

Confirm with [Assign IP configuration].

Note!

Direct after the assignment the Ethernet PG/OP channel may be reached
online by these address data.

The value remains as long as it is reassigned, it is overwritten by a
hardware configuration or an factory reset is executed.

Open the Siemens hardware configurator und configure the Siemens
CPU 315-2AG10 (315-2AG10-0AB00 V2.6).

Configure the modules at the standard bus.

For the Ethernet PG/OP channel you have to configure a Siemens
CP 343-1 (SIMATIC 300 \ CP 300 \ Industrial Ethernet \CP 343-1 \
6GK7 343-1EX11 OXEOQ) always below the really plugged modules.

Open the property window via double-click on the CP 343-1EX11 and
enter for the CP at "Properties" the IP address data, which you have
assigned before.

Transfer your project.

Standard bus (serial) — Standard bus

Slot | Module
1
2 CPU
X...

o
Qo
=
)
a
<
[}
=
=
[}
<
£S
L

DI DO DIO Al AO

Ethernet-PG/OP channel

343-1EX11

2B oo (N o o & e
>
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Setting CPU parameters

Parameterization
via Siemens
CPU 315-2AG10

Supported
parameters

General

Short description

Order No. /
Firmware

Name

Interface
Properties

Comment

Since the CPU 314-2BG03 of VIPA is to be configured as Siemens CPU
315-2DP (CPU 315-2AG10 V2.6) in the Siemens hardware configurator,
the parameters of the VIPA CPU may be set with "Object properties"
during hardware configuration.

Via a double-click on the CPU 315-2DP the parameter window of the CPU
may be accessed.

Using the registers you get access to all parameters of the CPU.

Parameter CPU
SIOt MOdU|e Param: ......... Param: .........
1 ” Param: ......... Param : .........
P D P D
2 | CPU.. - Param Param 1"
X2 DP
3
4

The CPU does not evaluate all parameters that may be set at the hardware
configuration.

The following parameters are supported at this time:

Since the VIPA CPU 314-2BGO03 is configured as CPU 315-2AG10 from
Siemens, here the short description CPU 315-2DP stands.

Order number and firmware are identical to the details in the "Hardware
catalog" window.

The Name field provides a short description of the module, which you can
change to meet your requirements. If you change the description, the new
description appears in the SIMATIC Manager.

Here the address of the MPI interface stands.
Click the "Properties" button to change the properties of the MPI interface.

In this field information about the module may be entered.
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Startup

Startup when
expected/actual
configuration differs

Monitoring time for
ready message by
modules [100ms]

Monitoring time for
transfer of
parameters to
modules [100ms]

Cycle/Clock
memory

Update OB1
process image
cyclically

Scan cycle
monitoring time

Minimum scan
cycle time

Scan cycle load
from Communi-
cation

Size of the process
image input/output
area

If the checkbox for "Startup when expected/actual configuration differ" is
deselected and at least one module is not located at its configured slot or if
another type of module is inserted there instead, then the CPU does not
switch to RUN mode and remains in STOP mode.

If the checkbox for "Startup when expected/actual configuration differ" is
selected, then the CPU starts even if there are modules not located in their
configured slots of if another type of module is inserted there instead, such
as during an initial system start-up.

This operation specifies the maximum time for the ready message of every
configured module after PowerON. Here connected PROFIBUS DP slaves
are also considered until they are parameterized. If the modules do not
send a ready message to the CPU by the time the monitoring time has
expired, the actual configuration becomes unequal to the preset
configuration.

The maximum time for the transfer of parameters to parameterizable
modules. If not every module has been assigned parameters by the time
this monitoring time has expired; the actual configuration becomes unequal
to the preset configuration.

This parameter is not relevant.

Here the scan cycle monitoring time in milliseconds may be set. If the scan
cycle time exceeds the scan cycle monitoring time, the CPU enters the
STOP mode. Possible reasons for exceeding the time are:

* Communication processes
» a series of interrupt events
* an error in the CPU program

This parameter is not relevant.

Using this parameter you can control the duration of communication
processes, which always extend the scan cycle time so it does not exceed
a specified length.

If the cycle load from communication is set to 50%, the scan cycle time of
OB 1 can be doubled. At the same time, the scan cycle time of OB 1 is still
being influenced by asynchronous events (e.g. hardware interrupts) as
well.

Here the size of the process image max. 2048 for the input/output
periphery may be fixed.

4-10
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0B85 call up at I/O
access error

Clock memory

Retentive Memory

Number of Memory
Bytes from MBO

Number of S7
Timers from TO

Number of S7
Counters from CO

Areas

Interrupts

Priority

The preset reaction of the CPU may be changed to an I/O access error that
occurs during the update of the process image by the system.

The VIPA CPU is preset such that OB 85 is not called if an I/O access error
occurs and no entry is made in the diagnostic buffer either.

Activate the check box if you want to use clock memory and enter the
number of the memory byte.

Note!
The selected memory byte cannot be used for temporary data storage.

Enter the number of retentive memory bytes from memory byte 0 onwards.

Enter the number of retentive S7 timers from TO onwards. Each S7 timer
occupies 2bytes.

Enter the number of retentive S7 counter from CO onwards.

These parameters are not relevant

Here the priorities are displayed, according to which the hardware interrupt

OBs are processed (hardware interrupt, time-delay interrupt, async. error
interrupts).
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Time-of-day
interrupts

Priority

Active

Execution

Start date / time

Process image
partition

Cyclic interrupts

Priority

Execution

Phase offset

Process image
partition

Protection
Level of protection

Here the priorities may be specified according to which the time-of-day
interrupt is processed.

With priority "0" the corresponding OB is deactivated.

Activate the check box of the time-of-day interrupt OBs if these are to be
automatically started on complete restart.

Select how often the interrupts are to be triggered. Intervals ranging from
every minute to yearly are available. The intervals apply to the settings
made for start date and time.

Enter date and time of the first execution of the time-of-day interrupt.

This parameter is not supported.

Here the priorities may be specified according to which the corresponding
cyclic interrupt is processed. With priority "0" the corresponding interrupt is
deactivated.

Enter the time intervals in ms, in which the watchdog interrupt OBs should
be processed. The start time for the clock is when the operating mode
switch is moved from STOP to RUN.

Enter the delay time in ms for current execution for the watch dog interrupt.
This should be performed if several watchdog interrupts are enabled.
Phase offset allows to distribute processing time for watchdog interrupts
across the cycle.

This parameter is not supported.

Here 1 of 3 protection levels may be set to protect the CPU from
unauthorized access.

Protection level 1 (default setting):

* No password adjustable, no restrictions
Protection level 2 with password:

* Authorized users: read and write access

» Unauthorized user: read access only
Protection level 3:

* Authorized users: read and write access

* Unauthorized user: no read and write access

4-12
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Project transfer

Overview

Transfer via MPI

Net structure

MPI programming

cable

Terminating resistor

STEP7

from Siemens

[ —
[

There are the following possibilities for project transfer into the CPU:
» Transfer via MPI

» Transfer via Ethernet

» Transfer via MMC

For transfer via MPI there is the following interface:
* X2: MPI interface

The structure of a MPI net is electrically identical with the structure of a
PROFIBUS net. This means the same rules are valid and you use the
same components for the build-up. The single participants are connected
with each other via bus interface plugs and PROFIBUS cables.

Please consider with the CPU 314-2BG03 that the total extension of the
MPI net does not exceed 50m. Per default the MPI net runs with
187.5kbaud. VIPA CPUs are delivered with MPI address 2.

The MPI programming cables are available at VIPA in different variants.
The cables provide a RS232 res. USB plug for the PC and a bus enabled
RS485 plug for the CPU.

Due to the RS485 connection you may plug the MPI programming cables
directly to an already plugged plug on the RS485 jack. Every bus
participant identifies itself at the bus with an unique address, in the course
of the address 0 is reserved for programming devices.

A cable has to be terminated with its surge impedance. For this you switch
on the terminating resistor at the first and the last participant of a network
or a segment.

Please make sure that the participants with the activated terminating

resistors are always power supplied. Otherwise it may cause interferences
on the bus.

Termination MPI net Termination
s *a

MPI programming cable i i

= =

+—max.50m ——»
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Approach transfer
via MPI interface

Connect your PC to the MPI jack of your CPU via a MPI programming
cable.

Load your project in the SIMATIC Manager from Siemens.
Choose in the menu Options > Set PG/PC interface.

Select in the according list the "PC Adapter (MPI)"; if appropriate you
have to add it first, then click on [Properties].

Set in the register MPI the transfer parameters of your MPI net and type
a valid address.

Switch to the register Local connection.

Set the COM port of the PCs and the transfer rate 38400Baud for the
MPI programming cable from VIPA.

Via PLC > Load to module you may transfer your project via MPI to the
CPU and save it on a MMC via PLC > Copy RAM to ROM if one is

plugged.

4-14
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Transfer via

Ethernet

Initialization

Transfer

For transfer via Ethernet the CPU has the following interface:

X4: Ethernet PG/OP channel

So that you may access the Ethernet PG/OP channel you have to assign
IP address parameters by means of the "initialization"(see "hardware
configuration - Ethernet PG/OP channel".

Information about the initialization of the Ethernet PG/OP channel may be
found at "Initialization of Ethernet PG/OP channel".

For the transfer, connect, if not already done, the appropriate Ethernet
port to your Ethernet.

Open your project with the Siemens SIMATIC Manager.
Set via Options > Set PG/PC Interface the access path to "TCP/IP ->

Network card .... ".

Click to PLC > Download — the dialog "Select target module" is opened.
Select your target module and enter the IP address parameters of the
Ethernet PG/OP channel for connection. Provided that no new hardware
configuration is transferred to the CPU, the entered Ethernet connection
is permanently stored in the project as transfer channel.

With [OK] the transfer is started.

Note!

System dependent you get a message that the projected system differs
from target system. This message may be accepted by [OK].

— your project is transferred and may be executed in the CPU after
transfer.
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Transfer via
MMC

Transfer
MMC - CPU

Transfer
CPU - MMC

Transfer control

The MMC (Memory Card) serves as external transfer and storage medium.
There may be stored several projects and sub-directories on a MMC
storage module. Please regard that your current project is stored in the root
directory and has one of the following file names:

» S7PROG.WLD
* AUTOLOAD.WLD

With File > Memory Card File > New in the Siemens SIMATIC Manager a
new wid file may be created. After the creation copy the blocks from the
project blocks folder and the System data into the wid file.

The transfer of the application program from the MMC into the CPU takes
place depending on the file name after an overall reset or PowerON.

e S7PROG.WLD is read from the MMC after overall reset.
« AUTOLOAD.WLD is read after PowerON from the MMC.

The blinking of the LED "MCC" of the CPU marks the active transfer.
Please regard that your user memory serves for enough space, otherwise
your user program is not completely loaded and the SF LED gets on.

When the MMC has been installed, the write command stores the content
of the battery buffered RAM as S7TPROG.WLD on the MMC.

The write command is controlled by means of the block area of the
Siemens SIMATIC manager PLC > Copy RAM to ROM. During the write
process the "MCC"-LED of the CPU is blinking. When the LED expires the
write process is finished.

If this project is to be loaded automatically from the MMC with PowerON,
you have to rename this on the MMC to AUTOLOAD.WLD.

After a MMC access, an ID is written into the diagnostic buffer of the CPU.
To monitor the diagnosis entries, you select PLC > Module Information in
the Siemens SIMATIC Manager. Via the register "Diagnostic Buffer" you
reach the diagnosis window.

When accessing a MMC, the following events may occur:
Event-ID Meaning
OxE100 MMC access error

OxE101 MMC error file system
OxE102 MMC error FAT

0xE104 MMC-error with storing

0xE200 MMC writing finished successful

0xE210 MMC reading finished (reload after overall reset)
OxE21F Error during reload, read error, out of memory

4-16
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Access to the internal Web page

Access to the The Ethernet PG/OP channel provides a web page that you may access
web page via an Internet browser by its IP address. The web page contains
information about firmware versions, current cycle times etc.

The current content of the web page is stored on MMC by means of the
MMC-Cmd WEBPAGE. More information may be found at "MMC-Cmd -
Auto commands".

Requirements A PG/OP channel connection should be established between PC with
Internet browser and CPU314-2BG03. This may be tested by Ping to the IP
address of the PG/OP channel.

Web page The access takes place via the IP address of the Ethernet PG/OP
-5 -@@ala channel. The web page only serves for information output. The monitored
ncdr |, s qgn.am values are not alterable.

IP PG/OP
CPU W TH ETHERNET PG OP
Sl ot 100
VI PA 314-2B®03 V.... Px000093. pkg, Order no., firmware vers., package,
SERI ALNUMBER 000638 serial no.
SUPPORTDATA : Information for support

PRODUCT V2060, HARDWARE V0111, 5679B- V11,
Hx000049. 100, Bx000152 V5060, Ax000055
V1090, Ax000056 V0200, Fl ashFil eSystem V102

Menorysi zes( Byt es) : LoadMem 524288, Information about memory

Wor kMentCode: 65536, Wor kMenDat a: 65536 configuration, load memory,
work memory (code/data)

OnBoar dEt hernet : MacAddress : 0020d5900014a, Ethernet PG/OP: Addresses

| P-Address : , SubnetMask : , Gateway :

Cpu state : Stop CPU state

Function RS485 X2/ COML: MPI Operating mode RS485

Functi on RS485 X3/ COMVR: DPS (MPI: MPI operation, DPS: DP slave,
off: de-activated)

Cycletine [mcroseconds] : mn=0 cur=0 ave=0 CPU cycle time:

max=0 min= minimal

cur= current
max= maximal

MCC-Tri al - Ti me: 70: 23 Remaining time in hh:mm for deacti-
vation of the expansion memory if

MCC is removed.
ArmLoad[ percent]:cur=11, max=11 Information for support

St andard Bus
BaudRat e Read Mbdel, BaudRate Wite Mde 1 Information for support
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Operating modes

Overview

Operating mode
STOP

Operating mode
START-UP

Operating mode
RUN

The CPU can be in one of 4 operating modes:
» Operating mode STOP

e Operating mode START-UP

» Operating mode RUN

» Operating mode HOLD

Certain conditions in the operating modes START-UP and RUN require a
specific reaction from the system program. In this case the application
interface is often provided by a call to an organization block that was
included specifically for this event.

» The application program is not processed.

» If there has been a processing before, the values of counters, timers,
flags and the process image are retained during the transition to the
STOP mode.

» Outputs are inhibited, i.e. all digital outputs are disabled.
* RUN-LED off
» STOP-LED on

* During the transition from STOP to RUN a call is issued to the start-up
organization block OB 100. The processing time for this OB is not
monitored. The START-UP OB may issue calls to other blocks.

» All digital outputs are disabled during the START-UP, i.e. outputs are
inhibited.
* RUN-LED blinks as soon as the OB 100 is operated and for at least

3s, even if the start-up time is shorter or the CPU gets to
STOP due to an error. This indicates the start-up.

e« STOP-LED off

When the CPU has completed the START-UP OB, it assumes the
operating mode RUN.

» The application program in OB 1 is processed in a cycle. Under the
control of alarms other program sections can be included in the cycle.

» All timers and counters being started by the program are active and the
process image is updated with every cycle.

» The BASP-signal (outputs inhibited) is deactivated, i.e. all digital outputs
are enabled.

* RUN-LED on
« STOP-LED off

4-18
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Operating mode
HOLD

Precondition

Approach for
working with
breakpoints

Behavior in
operating state
HOLD

The CPU offers up to 3 breakpoints to be defined for program diagnosis.
Setting and deletion of breakpoints happens in your programming
environment. As soon as a breakpoint is reached, you may process your
program step by step.

For the usage of breakpoints, the following preconditions have to be
fulfilled:

Testing in single step mode is only possible with STL. If necessary
switch the view via View > STL to STL.

The block must be opened online and must not be protected.
The open block must not be altered in the editor.

Activate View > Breakpoint Bar.

Set the cursor to the command line where you want to insert a
breakpoint.

Set the breakpoint with Debug > Set Breakpoint. The according
command line is marked with a circle.

To activate the breakpoint click on Debug > Breakpoints Active. The
circle is changed to afilled circle.

Bring your CPU into RUN. When the program reaches the breakpoint,
your CPU switches to the state HOLD, the breakpoint is marked with an
arrow and the register contents are monitored.

Now you may execute the program code step by step via Debug >
Execute Next Statement or run the program until the next breakpoint via
Debug > Resume.

Delete (all) breakpoints with the option Debug > Delete All Breakpoints.

The LED RUN blinks and the LED STOP is on.

The execution of the code is stopped. No level is further executed.
All times are frozen.

The real-time clock runs is just running.

The outputs were disabled (BASP is activated).

Configured CP connections remain exist.

Note!

The usage of breakpoints is always possible. Switching to the operating
mode test operation is not necessary.

With more than 2 breakpoints, a single step execution is not possible.
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Function The CPUs include security mechanisms like a Watchdog (100ms) and a
security parameterizable cycle time surveillance (parameterizable min. 1ms) that
stop res. execute a RESET at the CPU in case of an error and set it into a
defined STOP state.
The VIPA CPUs are developed function secure and have the following
system properties:
Event concerns Effect
RUN - STOP |general BASP (Befehls-Ausgabe-Sperre, i.e. command
output lock) is set.
central digital outputs The outputs are disabled.
central analog outputs The Outputs are disabled.
- Voltage outputs issue 0V
- Current outputs 0...20mA issue OmA
- Current outputs 4...20mA issue 4mA
If configured also substitute values may be
issued.
decentral outputs Same behavior as the central digital/analog
outputs.
decentral inputs The inputs are cyclically be read by the decentra-
lized station and the recent values are put at
disposal.
STOP - RUN |general First the Pll is deleted, then OB 100 is called. After

res. PowerON

the execution of the OB, the BASP is reset and
the cycle starts with:
Delete PIO - Read PIl -~ OB 1.

central analog outputs

The behavior of the outputs at restart can be
preset.

decentral inputs

The inputs are cyclically be read by the decentra-
lized station and the recent values are put at
disposal.

RUN

general

The program execution happens cyclically and can
therefore be foreseen:
Read PIl - OB 1 - Write PIO.

Pll = Process image inputs
PIO = Process image outputs

4-20
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Overall reset

Overview

Overall reset by
means of the
function selector

During the overall reset the entire user memory (RAM) is erased. Data
located in the memory card is not affected.

You have 2 options to initiate an overall reset:
* initiate the overall reset by means of the function selector switch
* initiate the overall reset by means of the Siemens SIMATIC Manager

Note!

You should always issue an overall reset to your CPU before loading an
application program into your CPU to ensure that all blocks have been
cleared from the CPU.

Condition

The operating mode of the CPU is STOP. Place the function selector on
the CPU in position "STOP" - the STOP-LED is on.

Overall reset

» Place the function selector in the position MRES and hold it in this
position for app. 3 seconds. - The STOP-LED changes from blinking to
permanently on.

» Place the function selector in the position STOP and switch it to MRES
and quickly back to STOP within a period of less than 3 seconds.

— The STOP-LED blinks (overall reset procedure).

» The overall reset has been completed when the STOP-LED is on

permanently. -~ The STOP-LED is on.

The following figure illustrates the above procedure:

@ ©) ©)

®)

PWR PWR PWR PWR
RUN RUN RUN RUN
AN pd N pd
—J [SFoP STOP —J StopP SToP
TN ~ 77T\ ~
SF SF SF SF
FRCE FRCE FRCE FRCE
N N N N
RUN RUN RUN RUN
3 Sec. l @ STOP STOP l @ STOP STOP
MRES MRES MRES MRES

3 Sec. |
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Automatic reload

Overall reset by
means of the
Siemens SIMATIC
Manager

Automatic reload

Set back to factory
setting

If there is a project STPROG.WLD on the MMC, the CPU attempts to
reload this project from MMC - the MCC LED is on.

When the reload has been completed the LED expires. The operating
mode of the CPU will be STOP or RUN, depending on the position of the
function selector.

Condition

The operating mode of the CPU must be STOP.
You may place the CPU in STOP mode by the menu command
PLC > Operating mode.

Overall reset

You may request the overall reset by means of the menu command PLC >
Clean/Reset.

In the dialog window you may place your CPU in STOP mode and start the
overall reset if this has not been done as yet.

The STOP-LED blinks during the overall reset procedure.

When the STOP-LED is on permanently the overall reset procedure has
been completed.

If there is a project STPROG.WLD on the MMC, the CPU attempts to
reload this project from MMC - the MCC LED is on.

When the reload has been completed, the LED expires. The operating
mode of the CPU will be STOP or RUN, depending on the position of the
function selector.

The following approach deletes the internal RAM of the CPU completely
and sets it back to the delivery state.

Please regard that the MPI address is also set back to default 2!
More information may be found at the part "Factory reset" further below.
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Firmware update

Overview

Latest firmware at
www.vipa.de

There is the possibility to execute a firmware update of the CPU and its
components via MMC. For this an accordingly prepared MMC must be in
the CPU during the startup.

So a firmware files can be recognized and assigned with startup, a pkg file
name is reserved for each updateable component an hardware release,
which begins with "px" and differs in a number with six digits.

The pkg file name of every updateable component may be found at a label
right down the front flap of the module.

As soon as with startup a pkg file is on the MMC and the firmware is more
current than in the components, the entire pkg file assigned components
within the CPU get the new firmware.

Firmware package and version
CPU 314SE/DPS

The latest firmware versions may be found in the service area of
www.vipa.de.

For example the following file is necessary for the firmware update of the
CPU 314-2BG03 with hardware release 1:

» 314-2BG03, Hardware release 1: Px000093.pkg

Attention!

When installing a new firmware you have to be extremely careful. Under
certain circumstances you may destroy the CPU, for example if the voltage
supply is interrupted during transfer or if the firmware file is defective.

In this case, please call the VIPA-Hotline!

Please regard that the version of the update firmware has to be different
from the existing firmware otherwise no update is executed.
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Display the
Firmware version of
the SPEED7 system
via web page

Load firmware and
transfer it to MMC

The CPU has an integrated web page that monitors information about
firmware version of the SPEED7 components. The Ethernet PG/OP
channel provides the access to this web page.

To activate the PG/OP channel you have to enter according IP parameters.

This can be made in Siemens SIMATIC manager either by a hardware
configuration, loaded by MMC respectively MPI or via Ethernet by means of
the MAC address with PLC > Assign Ethernet Address.
After that you may access the PG/OP channel with a web browser via the
IP address of the project engineering. More detailed information is to find in
the manual at "Initialization Ethernet PG/OP channel".

* Go to www.vipa.de.
e Click on Service > Download > Firmware.

* Navigate via System 300S > CPU to your CPU and download the zip file
to your PC.

» Extract the zip file and copy the extracted pkg file to your MMC.

Attention!

With a firmware update an overall reset is automatically executed. If your
program is only available in the load memory of the CPU it is deleted! Save
your program before executing a firmware update! After the firmware
update you should execute a "Set back to factory settings" (see following

page).
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Transfer firmware 1.
from MMC into
CPU

Switch the operating mode switch of your CPU in position STOP. Turn
off the voltage supply. Plug the MMC with the firmware files into the
CPU. Please take care of the correct plug-in direction of the MMC. Turn
on the voltage supply.

2. After a short boot-up time, the alternate blinking of the LEDs SF and
FRCE shows that at least a more current firmware file was found on the
MMC.
3. You start the transfer of the firmware as soon as you tip the operating
mode switch lever downwards to MRES within 10s.
4. During the update process, the LEDs SF and FRCE are alternately
blinking and MMC LED is on. This may last several minutes.
5. The update is successful finished when the LEDs PWR, STOP, SF,
FRCE and MCC are on. If they are blinking fast, an error occurred.
6. Turn Power OFF and ON. Now the CPU checks, whether further
current firmware versions are available at the MMC. If so, again the
LEDs SF and FRCE flash after a short start-up period. Continue with
point 3.
7. If the LEDs do not flash, the firmware update is ready.
8. Now a factory reset should be executed (see next page). After that the
CPU is ready for duty.
Preparation Firmware Start update Update runs Update Error
recognized terminates
l RUN at MMC error free
STOP . _ _ _ _
EPWR  [HPWR BPWR  [EPWR ElPWR PWR
MRES — — ] ] L
[ |RUN [ |RUN [ |RUN [ |IRUN [ |RUN N RL}N
l N :ST/OP [_|sToP N :ST/OP [_|sTopP [_|stop z gr\OP
s — —Jms H -Hs
Insert MMC /?EF::CE::Ef-RCE T'p RUN /?EECE——E:-:;/CE =ZZCE z %lz/-CE
“Imce 7 [imce STOPSTOP “mcc 7 [mcc  [Tmcc  Z3TMEC  power
Power OFF/ON H - MRES MRES | | - - "1 OFF/ON
10 Sec.
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Factory reset

Proceeding

)

2)

Wit

h the following proceeding the internal RAM of the CPU is completely

deleted and the CPU is reset to delivery state. Please note that here also

the

IP address of the Ethernet PG/OP channel is set to 0.0.0.0 and the MPI

address is reset to the address 2!

A factory reset may also be executed by the MMC-Cmd FACTORY_
RESET. More information may be found at "MMC-Cmd - Auto commands".

Switch the CPU to STOP.

Push the operating mode switch down to position MRES for 30s. Here
the STOP-LED flashes. After a few seconds the stop LED changes to
static light. Now the STOP LED changes between static light and
flashing. Starting here count the static light states.

After the 6. static light release the operating mode switch and tip it
downwards to MRES. Now the RUN LED lights up once. This means
that the RAM was deleted completely.

For the confirmation of the resetting procedure the LEDs PWR, STOP,
SF, FRCE and MCC get ON. If not, the factory reset has failed and only
an overall reset was executed. In this case you can repeat the
procedure. A factory reset can only be executed if the stop LED has
static light for exactly 6 times.

The end of factory reset is shown by static light of the LEDs STOP, SF,
FRCE and MCC. Switch the power supply off and on.

The proceeding is shown in the following lllustration:

5 ONNINNC

CPUin Request factory reset Start factory reset Factory reset  Error: Only
STOP executed overall reset
executed
PLC PLC PLC PLC PLC PLC
EPwWR EPwr EPwr EPwr  [EPWR EPwr
[ |RUN [ |RUN [ |RUN ERUN [ |RUN [ |RUN
. Nz . ] . .
["|sToP — > §top ["|sToP [“|sToP [[|sTOP [|sToP
|_|sF |_|sF |_|sF |_|sF SF |_|sF
- Tip RUN [ < 6x ): RUN  Tip - - -
| |FRCE | |FRCE 7FRCE | |FRCE [|FRCE | |FRCE
Imcc l @ STOP M lvce IMcc i STOP ‘ @ STOP Mmcc  [[Imcc Mcc Power
m MRES || ] MRES MRES || N ] OFF/ON
30 Sec. | | 1 Sec. |
Note!
After the firmware update you always should execute a Factory reset.
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Slot for storage media

Overview

Accessing the
storage medium

After overall reset

After PowerON

Once in STOP

At the front of the CPU there is a slot for storage media.
As external storage medium for applications and firmware you may use a
multimedia card (MMC) or a VIPA MCC memory extension card. The MCC
can additionally be used as an external storage medium.

It has the PC compatible FAT16 file format.

You can cause the CPU to load a project automatically respectively to
execute a command file by means of pre-defined file names.

To the following times an access takes place on a storage medium:

» The CPU checks if there is a project STPROG.WLD. If exists the project
is automatically loaded.

* The CPU checks if there is a project PROTECT.WLD with protected
blocks. If exists the project is automatically loaded. These blocks are
stored in the CPU until the CPU is reset to factory setting or an empty
PROTECT.WLD is loaded.

» The CPU checks if a MCC memory extension card is put. If exists the
memory extension is enabled, otherwise a memory expansion, which
was activated before, is de-activated.

« The CPU checks if there is a project AUTOLOAD.WLD. If exists an
overall reset is established and the project is automatically loaded.

» The CPU checks if there is a command file with VIPA_CMD.MMC. [f
exists the command file is loaded and the containing instructions are
executed.

o After PowerON and CPU STOP the CPU checks if there is a *.pkg file
(firmware file). If exists this is indicated by blinking of the LEDs and the
firmware may be installed by an update request (see "Firmware update).

« If a storage medium is put, which contains a command file
VIPA_CMD.MMC, the command file is loaded and the containing
instructions are executed.
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Memory extension with MCC

Overview

VIPA

& ViPA553aLPo0

Approach

Behavior

There is the possibility to extend the work memory of the CPU.

For this, a MCC memory extension card is available from VIPA. The MCC
is a specially prepared MMC (Multimedia Card). By plugging the MCC into
the MCC slot and then an overall reset the according memory expansion is
released. There may only one memory expansion be activated at the time.

On the MCC there is the file memory.key. This file may not be altered or
deleted. You may use the MCC also as "normal" MMC for storing your
project.

To extend the memory, plug the MCC into the card slot at the CPU labeled
with "MCC" and execute an overall reset.

CPU Overall reset

=L ee @l

VR p Mmemory is extended for the MCC memory
configuration (diagnostic entry 0xE400)

If the memory expansion on the MCC exceeds the maximum extendable
memory range of the CPU, the maximum possible memory of the CPU is
automatically used.

You may determine the recent memory extension via the integrated web
page or with the Siemens SIMATIC Manager at Module Information -
"Memory".

Attention!

Please regard that the MCC must remain plugged when you've executed
the memory expansion at the CPU. Otherwise the CPU switches to STOP
after 72 hours. The MCC cannot be exchanged with a MCC of the same
memory configuration.

When the MCC memory configuration has been taken over you may find
the diagnosis entry 0xE400 in the diagnostic buffer of the CPU.

After pulling the MCC the entry 0xE401 appears in the diagnostic buffer,
the SF-LED is on and after 72 hours the CPU switches to STOP. A reboot
is only possible after plugging-in the MCC again or after an overall reset.
The remaining time after pulling the MCC is always been shown with the
parameter MCC-Trial-Time on the web page.

After re-plugging the MCC, the SF-LED extinguishes and 0xE400 is
entered into the diagnostic buffer.

You may reset the memory configuration of your CPU to the initial status at
any time by executing an overall reset without MCC.
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Extended know-how protection

Overview

Standard protection

Extended protection

PC

Blocks

y
] —

Protect blocks
with protect.wld

Besides the "standard" Know-how protection the SPEED7-CPUs from VIPA
provide an "extended" know-how protection that serves a secure block
protection for accesses of 3. persons.

The standard protection from Siemens transfers also protected blocks to
the PG but their content is not displayed. But with according manipulation
the Know-how protection is not guaranteed.

The "extended" know-how protection developed by VIPA offers the
opportunity to store blocks permanently in the CPU.

At the "extended" protection you transfer the protected blocks into a WLD-
file named protect.wld. By plugging the MMC and following overall reset,
the blocks in the protect.wld are permanently stored in the CPU.

You may protect OBs, FBs and FCs.

When back-reading the protected blocks into the PG, exclusively the block
header are loaded. The block code that is to be protected remains in the
CPU and cannot be read.

CPU OVERALL_RESET

@k 0 @l

RN H

(=p

MR
> —> ) protected Blocks

protect.wld

Create a new wid-file in your project engineering tool with File > Memory
Card file > New and rename it to "protect.wld".

Transfer the according blocks into the file by dragging them with the mouse
from the project to the file window of protect.wld.
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Transfer
protect.wld to CPU
with overall reset

Protection
behavior

Change respectively
delete protected
blocks

Usage of
protected blocks

Transfer the file protect.wld to a MMC storage module, plug the MMC into
the CPU and execute an overall reset with the following approach:

@ ©)

©
O

[ ]JPWR [ ]JPWR [ [PWR [ ]JPWR
| |RUN | |RUN | |RUN | |RUN
Nz ] N7 .
—J [sToP 3 8sToP —J [sToP 3 8ToP
//7 /7\ //7 /7\
| |SF | |SF | |SF | |SF
|_|FRCE |_|FRCE |_|FRCE |_|FRCE
[ Inee e e [ Inee
RUN RUN RUN RUN
s d o oo JGrow (B
MRES MRES MRES MRES
| 3 Sec. |

The overall reset stores the blocks in protect.wld permanently in the CPU
protected from accesses of 3. persons.

Protected blocks are overwritten by a new protect.wid.

Using a PG 3. persons may access protected blocks but only the block
header is transferred to the PG. The block code that is to be protected
remains in the CPU and cannot be read.

Protected blocks in the RAM of the CPU may be substituted at any time by
blocks with the same name. This change remains up to next overall reset.
Protected blocks may permanently be overwritten only if these are deleted
at the protect.wld before.

By transferring an empty protect.wld from the MMC you may delete all
protected blocks in the CPU.

Due to the fact that reading of a "protected" block from the CPU monitors
no symbol labels it is convenient to provide the "block covers" for the end
user.

For this, create a project out of all protected blocks. Delete all networks in
the blocks so that these only contain the variable definitions in the
according symbolism.
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MMC-Cmd - Auto commands

Overview

Command file

Commands

A command file at a MMC is automatically executed under the following
conditions:

e CPUisin STOP and MMC is stuck
» After each PowerON

The command file is a text file, which consists of a command sequence to
be stored as vipa_cmd.mmc in the root directory of the MMC.

The file has to be started by CMD_START as 1. command, followed by the
desired commands (no other text) and must be finished by CMD_END as
last command.

Text after the last command CMD_END e.g. comments is permissible,
because this is ignored. As soon as the command file is recognized and
executed each action is stored at the MMC in the log file logfile.txt. In
addition for each executed command a diagnostics entry may be found in
the diagnostics buffer.

Please regard the command sequence is to be started with CMD_START
and ended with CMD_END.

Command

Description Diagnostics entry

CMD_START

In the first line CMD START is to be located. OxE801

There is a diagnostic entry if CMD_START is missing OxE8BFE

WAIT1SECOND

Waits ca. 1 second. OxE803

WEBPAGE

The current web page of the CPU is stored at the MMC 0xE804

as "webpage.htm".

LOAD_PROJECT

The function "Overall reset and reload from MMC" is OxE805
executed. The wild file located after the command is

loaded else "s7prog.wld" is loaded.

SAVE_PROJECT

The recent project (blocks and hardware configuration) 0xE806
is stored as "s7prog.wld" at the MMC.

If the file just exists it is renamed to "s7prog.old".

If your CPU is password protected so you have to add
this as parameter. Otherwise there is no project written.

Example: SAVE PROJECT password

FACTORY_RESET

Executes "factory reset". 0xE807

DIAGBUF

The current diagnostics buffer of the CPU is stored as OxE80B

"diagbuff.txt" at the MMC.

SET_NETWORK

IP parameters for Ethernet PG/OP channel may be set OxE8OE
by means of this command.

The IP parameters are to be given in the order IP
address, subnet mask and gateway in the format

XXX.XXX.XXX.XXX each separated by a comma.
Enter the IP address if there is no gateway used.

CMD_END

In the last line CMD END is to be located. 0OxE802
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Examples

The structure of a command file is shown in the following. The

corresponding diagnostics entry is put in parenthesizes.

Example 1

CMD_START

LOAD PRQIECT proj.w d
WAl TLSECOND

WEBPAGE

DI AGBUF

CVMD_END

arbitrary text

Example 2

CMD_START
LOAD_PRQJECT proj 2. W d
WAl T1SECOND
WAl T1SECOND

SET_NETWORK 172. 16. 129. 210, 255. 255. 224. 0, 172. 16. 129. 210

WAl T1SECOND
WAl T1SECOND
W\EBPAGE
DI AGBUF
CMD_END

arbitrary text

Note!

Marks the start of the command sequence (0xE801)

Execute an overall reset and load "proj.wld" (OXE805)

Wait ca. 1s (OxE803)

Store web page as "webpage.htm" (0xE804)

Store diagnostics buffer of the CPU as "diagbuff.txt" (0xE80B)
Marks the end of the command sequence (0xE802)

Text after the command CMD_END is not evaluated.

Marks the start of the command sequence (0xE801)

Execute an overall reset and load "proj2.wld" (OXE805)

Wait ca. 1s (OxE803)

Wait ca. 1s (OxE803)

IP parameter
(OXE8OE)
Wait ca. 1s (OxE803)

Wait ca. 1s (OxE803)

Store web page as "webpage.htm" (0xE804)

Store diagnostics buffer of the CPU as "diagbuff.txt" (0xE80B)
Marks the end of the command sequence (0xE802)

Text after the command CMD_END is not evaluated.

The parameters IP address, subnet mask and gateway may be received
from the system administrator.

Enter the IP address if there is no gateway used.
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VIPA specific diagnostic entries

Entries in the You may read the diagnostic buffer of the CPU via the Siemens SIMATIC
diagnostic buffer Manager. Besides of the standard entries in the diagnostic buffer, the VIPA
CPUs support some additional specific entries in form of event-IDs.

The current content of the diagnostics buffer is stored on MMC by means
of the MMC-Cmd DIAGBUF. More information may be found at "MMC-Cmd
- Auto commands".

Note!

Every register of the module information is supported by the VIPA CPUs.
More information may be found at the online help of the Siemens SIMATIC
manager.

Monitoring the To monitor the diagnostic entries you choose the option PLC > Module
diagnostic entries  Information in the Siemens SIMATIC Manager. Via the register "Diagnostic
Buffer" you reach the diagnostic window:

Q/Iodule information j

Path: Accessible Nodes MPI = 2 Operating mode CPU: RUN

Q Diagnostic Buff4r | ‘

Nr. Time ofday Date Event
10 13:18:11:370 19.12.2011 Event-ID: 16# EOCC

i - - VIPA-ID

Details:

The diagnosis is independent from the operating mode of the CPU. You
may store a max. of 100 diagnostic entries in the CPU.

The following page shows an overview of the VIPA specific Event-IDs.
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Overview of the

Event-IDs
Event-ID | Description
OxEO003 | Error at access to 1/0O devices
Zinfo1: 1/0 address
Zinfo2: Slot
0xE004 | Multiple parameterization of a I/O address
Zinfo1: 1/0 address
Zinfo2: Slot
0xEO005 |Internal error - Please contact the VIPA-Hotline!
0xE006 | Internal error - Please contact the VIPA-Hotline!
0xEQQ7 | Configured in-/output bytes do not fit into I/O area
0xE008 | Internal error - Please contact the VIPA-Hotline!
0xEOQ09 | Error at access to standard back plane bus
0xEO010 | Not defined module group at backplane bus recognized
Zinfo2: Slot
Zinfo3: Type ID
0xEO011 Master project engineering at Slave-CPU not possible or wrong slave configuration
0xEOQ12 | Error at parameterization
0xEOQ13 | Error at shift register access to standard bus digital modules
0xEOQ14 | Error at Check Sys
OxEO015 | Error at access to the master
Zinfo2: Slot of the master (32=page frame master)
O0xEO016 | Maximum block size at master transfer exceeded
Zinfo1: 1/0 address
Zinfo2: Slot
0xEQ17 | Error at access to integrated slave
0xE018 | Error at mapping of the master periphery
0xEOQ19 | Error at standard back plane bus system recognition
O0xEOQ1A | Error at recognition of the operating mode (8 / 9 Bit)
0xEQ1B | Error - maximum number of plug-in modules exceeded
0xEQ20 | Error - interrupt information is not defined
0xE030 | Error of the standard bus
0xE033 |Internal error - Please contact the VIPA-Hotline!
O0xEOBQ | SPEED?Y is not stoppable (probably undefined BCD value at timer)
0xEOCO | Not enough space in work memory for storing code block (block size exceeded)
OXEOCC | Communication error MPI / Serial

Zinfo1: Code

1: Wrong Priority

2: Buffer overflow

3: Frame format error

7: Incorrect value

8: Incorrect RetVal

9: Incorrect SAP

10: Incorrect connection type

11: Incorrect sequence number

12: Faulty block number in the telegram
13: Faulty block type in the telegram
14: Inactive function

15: Incorrect size in the telegram
20: Error writing to MMC

90: Incorrect Buffer size

98: Unknown error

99: Internal error
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Event-ID | Description
OxEQOCD | Error at DPV1 job management
OxEOQOCE | Error: Timeout at sending of the i-slave diagnostics
0xE100 | MMC access error
0xE101 MMC error file system
0xE102 | MMC error FAT
0xE104 | MMC error at saving
0xE200 | MMC writing finished (Copy Ram2Rom)
0xE210 | MMC reading finished (reload after overall reset)
0xE21F | MMC reading: error at reload (after overall reset), read error, out of memory
0xE300 | Internal flash writing finished (Copy Ram2Rom)
0xE310 | Internal flash writing finished (reload after battery failure)
0xE400 | Memory expansion MCC has been plugged
0xE401 Memory expansion MCC has been removed
0xE801 MMC-Cmd: CMD START recognized and successfully executed
0xE802 | MMC-Cmd: CMD END recognized and successfully executed
0xE803 | MMC-Cmd: WAIT1SECOND recognized and successfully executed
0xE804 | MMC-Cmd: WEBPAGE recognized and successfully executed
0xE805 | MMC-Cmd: LOAD PROJECT recognized and successfully executed
0xE806 | MMC-Cmd: SAVE PROJECT recognized and successfully executed
0xE807 | MMC-Cmd: FACTORY RESET recognized and successfully executed
0xE80B | MMC-Cmd: DIAGBUF recognized and successfully executed
OxE8O0E |MMC-Cmd: SET _NETWORK recognized and successfully executed
OxE8FB | MMC-Cmd: Error: Initialization error of the Ethernet-PG/OP channel by means of
SET_NETWORK.
OxE8FC | MMC-Cmd: Error: Some IP parameters are missing in SET NETWORK.
OxE8FE | MMC-Cmd: Error: CMD_START is missing
OxE8FF | MMC-Cmd: Error: Error while reading CMD file (MMC error)
0xE901 Check sum error
OXEAO0 |Internal error - Please contact the VIPA-Hotline!
OxEAO01 Internal error - Please contact the VIPA-Hotline!
OxEAO02 |SBUS: Internal error (internal plugged sub module not recognized)
Zinfo1: Internal slot
OxEA03 | SBUS: Communication error CPU - PROFINET-IO-Controller
Zinfo1: Slot
Zinfo2: Status (0: OK, 1: ERROR, 2: BUSSY, 3: TIMEOUT, 4: LOCKED, 5: UNKNOWN)
OxEAO04 | SBUS: Multiple parameterization of a I/O address
Zinfo1: 1/0 address
Zinfo2: Slot
Zinfo3: Data width
OXEAO05 |Internal error - Please contact the VIPA-Hotline!
OXEAO7 |Internal error - Please contact the VIPA-Hotline!
OxEAO08 |SBUS: Parameterized input data width unequal to plugged input data width

Zinfo1: Parameterized input data width
Zinfo2: Slot
Zinfo3: Input data width of the plugged module
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Event-ID | Description

OxEAQ9 |SBUS: Parameterized output data width unequal to plugged output data width
Zinfo1: Parameterized output data width

Zinfo2: Slot

Zinfo3: Output data width of the plugged module

OxEA10 | SBUS: Input address outside input area
Zinfo1: 1/0 address

Zinfo2: Slot

Zinfo3: Data width

OxEA11 | SBUS: Output address outside output area
Zinfo1: I/0 address

Zinfo2: Slot

Zinfo3: Data width

OxEA12 | SBUS: Error at writing record set
Zinfo1: Slot

Zinfo2: Record set number
Zinfo3: Record set length

OxEA14 | SBUS: Multiple parameterization of a I/O address (Diagnostic address)
Zinfo1: 1/0 address

Zinfo2: Slot

Zinfo3: Data width

OxEA15 Internal error - Please contact the VIPA-Hotline!

OxEA18 | SBUS: Error at mapping of the master I/O devices
Zinfo2: Master slot

OxEA19 Internal error - Please contact the VIPA-Hotline!

OxEA20 Error - RS485 interface is not set to PROFIBUS DP master but there is a
PROFIBUS DP master configured.

OxEA21 | Error - Project engineering RS485 interface X2/X3:
PROFIBUS DP master is configured but missing
Zinfo2: Interface x

OxEA22 |Error - RS485 interface X2 - value is out of range
Zinfo: Configured value X2

OxEA23 |Error - RS485 interface X3 - value is out of range
Zinfo: Configured value X3

OxEA24 | Error - Project engineering RS485 interface X2/X3:
Interface/Protocol is missing, the default settings are used.
Zinfo2: Configured value X2

Zinfo3: Configured value X3

OxEA30 Internal error - Please contact the VIPA-Hotline!

OxEA40 Internal error - Please contact the VIPA-Hotline!

OxEA41 Internal error - Please contact the VIPA-Hotline!

OXEA50 |Error - PROFINET configuration

Zinfo1: User slot of the PROFINET IO controller
Zinfo2: 10 device number

Zinfo3: 10 device slot

OXEAS51 | Error - there is no PROFINET 10 controller at the configured slot
Zinfo1: User slot of the PROFINET 10 controller
Zinfo2: Recognized ID at the configured slot

4-36 HB140E - CPU - RE_314-2BG03 - Rev. 12/06



Manual VIPA System 300S SPEED?7 Chapter 4 Deployment CPU 314-2BG03

Event-ID | Description

O0xEA54 |Error - PROFINET 1O controller reports multiple configuration at one peripheral
addr.

Zinfo1: Peripheral address

Zinfo2: User slot of the PROFINET 1O controller

Zinfo3: Data width

OxEA64 |PROFINET configuration error:
Zinfo1: error word

Bit 0: too many 1O devices

Bit 1: too many IO devices per ms

Bit 2: too many input bytes per ms

Bit 3: too many output bytes per ms

Bit 4: too many input bytes per device

Bit 5: too many output bytes per device

Bit 6: too many productive connections

Bit 7: too many input bytes in the process image
Bit 8: too many output bytes in the process image
Bit 9: Configuration not available

Bit 10: Configuration not valid

OxEA65 | Communication error CPU - PROFINET-IO-Controller
Pk : CPU or PROFINET-IO-Controller

Zinfo1: Service ID, with which the error arose

Zinfo2: Command, with which the error arose

OxEA66 Internal error - Please contact the VIPA-Hotline!

OxEAG67 |Error - PROFINET-IO-Controller - reading record set
Pk: Error type

0: DATA_RECORD_ERROR_LOCAL

1: DATA_RECORD_ERROR_STACK

2: DATA_RECORD_ERROR_REMOTE

OBNr: PROFINET-IO-Controller slot

Datld: Device no.

Zinfo1: Record set number

Zinfo2: Record set handle

Zinfo3: Internal error code for service purposes

OxEA68 |Error - PROFINET-IO-Controller - writing record set
Pk: Error type

0: DATA_RECORD_ERROR_LOCAL

1: DATA_RECORD_ERROR_STACK

2: DATA_RECORD_ERROR_REMOTE

OBNr: PROFINET-IO-Controller slot

Datld: Device no.

Zinfo1: Record set number

Zinfo2: Record set handle

Zinfo3: Internal error code for service purposes

OxEA97 | Storage error SBUS service channel
Zinfo3 = Slot

OxEA98 | Timeout at waiting for reboot of a SBUS module (Server)

OxEA99 |Error at file reading via SBUS

OXEEOO |Additional information at UNDEF_OPCODE

OxEEEE | CPU was completely overall reset, since after PowerON the start-up could not be
finished.

OxEFFF Internal error - Please contact the VIPA-Hotline!
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Using test functions for control and monitoring of variables

Overview

Debug > Monitor

For troubleshooting purposes and to display the status of certain variables
you can access certain test functions via the menu item Debug of the
Siemens SIMATIC Manager.

The status of the operands and the VKE can be displayed by means of the
test function Debug > Monitor.

You can modify and/or display the status of variables by means of the test
function PLC > Monitor/Modify Variables.

This test function displays the current status and the VKE of the different
operands while the program is being executed.

It is also possible to enter corrections to the program.

Note!
When using the test function “Monitor” the PLC must be in RUN mode!

The processing of the states may be interrupted by means of jump
commands or by timer and process-related alarms. At the breakpoint the
CPU stops collecting data for the status display and instead of the required
data it only provides the PG with data containing the value 0.

For this reason, jumps or time and process alarms can result in the value
displayed during program execution remaining at O for the items below:

+ the result of the logical operation VKE

» Status / AKKU 1

+ AKKU 2

» Condition byte

» absolute memory address SAZ. In this case SAZ is followed by a "?".

The interruption of the processing of statuses does not change the
execution of the program. It only shows that the data displayed is no
longer.
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PLC >
Monitor/Modify
Variables

This test function returns the condition of a selected operand (inputs,
outputs, flags, data word, counters or timers) at the end of program-
execution.

This information is obtained from the process image of the selected
operands. During the "processing check" or in operating mode STOP the
periphery is read directly from the inputs. Otherwise only the process
image of the selected operands is displayed.

Control of outputs
It is possible to check the wiring and proper operation of output-modules.

You can set outputs to any desired status with or without a control
program. The process image is not modified but outputs are no longer
inhibited.

Control of variables
The following variables may be modified:
,Q, M, T,CandD.

The process image of binary and digital operands is modified
independently of the operating mode of the CPU.

When the operating mode is RUN the program is executed with the
modified process variable. When the program continues they may,
however, be modified again without notification.

Process variables are controlled asynchronously to the execution sequence
of the program.
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Chapter 5

Overview

Content

Deployment PtP communication

Content of this chapter is the deployment of the RS485 interface for serial
PtP communication.

Here you'll find every information about the protocols, the activation and
project engineering of the interface, which are necessary for the serial
communication using the RS485 interface.

Topic Page
Chapter 5  Deployment PtP communication ..........cccceeeeeeveviviinnnnnnn. 5-1
Fast introduction...........ooooiiiii i 5-2
Principle of the data transfer ... 5-3
Deployment of RS485 interface for PtP...........ooooviiiiiiii e, 5-4
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COMMUNICALION ... e 5-9
Protocols and proCcedures ...........ooooiiiiiiiiiiiie e 5-15
Modbus - FUNCHION COAES ......ccoeieiiiiiieiee e 5-19
Modbus - Example communication.............cccooiviiiiiiiiiciiiie e 5-23
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Fast introduction

General

Protocols

Switch RS485 to
PtP operation

Parameterization

Communication

Overview SFCs
for serial
communication

The CPU has an integrated RS485 interface. The functionality of this
interface may be configured during hardware configuration by setting the
operating mode of the PROFIBUS part of the Siemens CPU (315-2AG10-
0ABOO V2.6).

Using the PtP functionality the RS485 interface is allowed to connect via
serial point-to-point connection to different source systems.

The protocols res. procedures ASCII, STX/ETX, 3964R, USS and Modbus
are supported.

To activate the PtP functionality set the PROFIBUS part to "Master"
operation without linking.

The parameterization of the serial interface happens during runtime using
the SFC 216 (SER_CFG). For this you have to store the parameters in a
DB for all protocols except ASCII.

The SFCs are controlling the communication. Send takes place via
SFC 217 (SER_SND) and receive via SFC 218 (SER_RCV).

The repeated call of the SFC 217 SER_SND delivers a return value for
3964R, USS and Modbus via RetVal that contains, among other things,
recent information about the acknowledgement of the partner station.

The protocols USS and Modbus allow to evaluate the receipt telegram by
calling the SFC 218 SER_RCV after SER_SND.

The SFCs are included in the consignment of the CPU.

The following SFCs are used for the serial communication:

SFC Description
SFC 216 SER _CFG RS485 parameterize
SFC 217 SER_SND RS485 send
SFC 218 SER _RCV RS485 receive

5-2
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Principle of the data transfer

Overview

Principle

The data transfer is handled during runtime by using SFCs. The principle of
data transfer is the same for all protocols and is shortly illustrated in the
following.

Data, which are written into the according data channel by the PLC, is
stored in a FIFO send buffer (first in first out) with a size of 2x1024byte
and then put out via the interface.

When the interface receives data, this is stored in a FIFO receive buffer
with a size of 2x1024byte and can there be read by the PLC.

If the data is transferred via a protocol, the adoption of the data to the
according protocol happens automatically.

In opposite to ASCII and STX/ETX, the protocols 3964R, USS and Modbus
require the acknowledgement of the partner.

An additional call of the SFC 217 SER_SND causes a return value in
RetVal that includes among others recent information about the
acknowledgement of the partner.

Further on for USS and Modbus after a SER_SND the acknowledgement
telegram must be evaluated by call of the SFC 218 SER_RCV.

RS485 PtP communication

Program

SER_RCV
SFC 218

SER_CFG
SFC 216

SER_SND
SFC 217

Protocol FIFO Buffer Interface
IN RS485
< RECEIVE A 1024Byte
1024Byte 4———
CFG ouT A

A 1024Byte| —»

—»| | 1024Byte
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Deployment of RS485 interface for PtP

Switch to PtP
operation

Hardware
configuration

Properties RS485

Connection
RS485

The functionality of the RS485 interface may be configured during
hardware configuration by setting the operating mode of the PROFIBUS
part of the Siemens CPU (315-2AG10-0AB00 V2.6).

To activate the PtP functionality set the PROFIBUS part to "Master"
operation without linking.

Start the Siemens hardware configurator.
Configure the Siemens CPU 315-2AG10 (6ES7 315-2AG10-0AB0/V2.6).

To use the interface as PtP interface leave at Properties PROFIBUS the
Subnet set to "not networked".

You may also open the Properties dialog of the PROFIBUS part of the
inserted CPU by double-clicking to the "DP" submodule, choosing the
Operating mode "DP Master" and setting the Subnet to "not networked".

Logical states represented by voltage differences between the two cores
of a twisted pair cable

Serial bus connection in two-wire technology using half duplex mode
Data communications up to a max. distance of 500m

Data communication rate up to 115.2kbaud

Pin | Assignment

n.c.

M24V

RxD/TxD-P (Line B)

RTS

M5V

PS5V

P24V

RxD/TxD-N (Line A)

OO NOO DWW N~

n.c.

5-4
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Connection
CPU - RS485 Periphery
R}DITXD-P (B) ° RXDITXD-P (B)
RxD/TxD-N (A) 8 RxD/TxD-N (A)
shield . i
Periphery
L RxD/TxD-P (B)
RxD/TxD-N (A)
[ J l

Periphery

RxD/TxD-P (B)

RxD/TxD-N (A)
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Parameterization

SFC 216 The parameterization happens during runtime deploying the SFC 216

(SER_CFGQG) (SER_CFG). You have to store the parameters for STX/ETX, 3964R, USS
and Modbus in a DB.

Name Declaration | Type Comment

Protocol IN BYTE 1=ASCII, 2=STX/ETX, 3=3964R

Parameter IN ANY Pointer to protocol parameters

Baudrate IN BYTE Velocity of data transfer

CharLen IN BYTE 0=5bit, 1=6bit, 2=7bit, 3=8bit

Parity IN BYTE 0=None, 1=0dd, 2=Even

StopBits IN BYTE 1=1bit, 2=1.5bit, 3=2bit

FlowControl |IN BYTE 1 (fix)

RetVal ouT WORD Error Code (0 = OK)

Parameter All time settings for timeouts must be set as hexadecimal value. Find the

description Hex value by multiply the wanted time in seconds with the baudrate.

Example: Wanted time 8ms at a baudrate of 19200baud
Calculation: 19200bit/s x 0.008s = 154bit — (9Ah)
Hex value is 9Ah.

Protocol Here you fix the protocol to be used. You may choose between:
1: ASCII
2: STX/IETX
3: 3964R
4: USS Master
5: Modbus RTU Master
6: Modbus ASCII Master
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Parameter (as DB)

Baud rate

CharlLen

At ASCII protocol, this parameter is ignored.

At STX/ETX, 3964R, USS and Modbus you fix here a DB that contains the
communication parameters and has the following structure for the
according protocols:

Data block at STX/ETX

DBBO0O: STX1 BYTE (1. Start-ID in hexadecimal)
DBB1: STX2 BYTE (2. Start-ID in hexadecimal)
DBB2: ETX1 BYTE (1. End-ID in hexadecimal)
DBB3: ETX2 BYTE (2. End-ID in hexadecimal)
DBW4: TIMEOUT WORD (max. delay time between 2 telegrams)

Note!

The start res. end sign should always be a value <20, otherwise the sign is
ignored!

Data block at 3964R

DBBO0: Prio BYTE (The priority of both partners must be
different)

DBB1: ConnAttmptNr BYTE (Number of connection trials)
DBB2: SendAttmptNr BYTE (Number of telegram retries)
DBW4: CharTimeout WORD (Character delay time)
DBW6: ConfTimeout WORD (Acknowledgement delay time)

Data block at USS
DBWO: Timeout WORD (Delay time in)

Data block at Modbus-Master
DBWO: Timeout WORD (Respond delay time)

Velocity of data transfer in bit/s (baud).

04h: 1200baud  05h: 1800baud 06h: 2400baud 07h: 4800baud
08h: 7200baud  09h: 9600baud O0Ah: 14400baud OBh: 19200baud
0Ch: 38400baud 0Dh: 57600baud OEh: 115200baud

Number of data bits where a character is mapped to.
0: 5bit 1: 6bit  2: 7bit 3: 8bit
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Parity

StopBits

FlowControl

RetVal SFC 216
(Error message
SER_CFG)

The parity is -depending on the value- even or odd. For parity control, the
information bits are extended with the parity bit that amends via its value
("0" or "1") the value of all bits to a defined status. If no parity is set, the
parity bit is set to "1", but not evaluated.

0: NONE 1:0DD 2: EVEN

The stop bits are set at the end of each transferred character and mark the
end of a character.

1: 1bit 2:1.5bit  3: 2bit

The parameter FlowControl is ignored. When sending RTS=1, when
receiving RTS=0.

Return values sent by the block:

Error code |Description

0000h no error

809Ah Interface is not available or
interface is used for PROFIBUS

8x24h Error at SFC-Parameter x, with x:

Error at "Protocol"

Error at "Parameter”

Error at "Baudrate"

Error at "CharLength"

Error at "Parity"

Error at "StopBits"

. Error at "FlowControl"

809xh Error in SFC parameter value x, where x:
Error at "Protocol"

Error at "Baudrate"

Error at "CharLength"

Error at "Parity"

Error at "StopBits"

Error at "FlowControl"

8092h Access error in parameter DB (DB too short)
828xh Error in parameter x of DB parameter, where x:
1: Error 1. parameter

2: Error 2. parameter

Nk w2

No g how
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Communication

Overview The communication happens via the send and receive blocks SFC 217
(SER_SND) and SFC 218 (SER_RCV).

The SFCs are included in the consignment of the CPU.

SFC 217 This block sends data via the serial interface.

(SER_SND) The repeated call of the SFC 217 SER_SND delivers a return value for
3964R, USS and Modbus via RetVal that contains, among other things,
recent information about the acknowledgement of the partner station.

The protocols USS and Modbus require to evaluate the receipt telegram by
calling the SFC 218 SER_RCV after SER_SND.

Parameter

Name Declaration | Type Comment

DataPtr IN ANY Pointer to Data Buffer for sending data

DataLen ouT WORD Length of data sent

RetVal ouT WORD Error Code (0 = OK)

DataPtr Here you define a range of the type Pointer for the send buffer where the
data that has to be sent is stored. You have to set type, start and length.
Example: Data is stored in DB5 starting at 0.0 with a length of

124byte.
DataPtr:=P#DB5.DBX0.0 BYTE 124

DatalLen Word where the number of the sent bytes is stored.

At ASCII if data were sent by means of SFC 217 faster to the serial
interface than the interface sends, the length of data to send could differ
from the DatalLen due to a buffer overflow. This should be considered by
the user program.

With STX/ETX, 3964R, Modbus and USS always the length set in DataPtr
is stored or O.
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RetVal SFC 217
(Error message
SER_SND)

Protocol specific
RetVal values

Return values of the block:

Error code |Description
0000h Send data - ready
1000h Nothing sent (data length 0)
20xxh Protocol executed error free with xx bit pattern for
diagnosis
7001h Data is stored in internal buffer - active (busy)
7002h Transfer - active
80xxh Protocol executed with errors with xx bit pattern for
diagnosis (no acknowledgement by partner)
90xxh Protocol not executed with xx bit pattern for diagnosis (no
acknowledgement by partner)
8x24h Error in SFC parameter x, where x:
1: Error in "DataPtr"
2: Error in "DataLen”
8122h Error in parameter "DataPtr" (e.g. DB too short)
807Fh Internal error
809Ah Interface not found or interface is used for PROFIBUS
809Bh Interface not configured
ASCII
Value Description
9000h Buffer overflow (no data send)
9002h Data too short (Obyte)
STX/ETX
Value Description
9000h Buffer overflow (no data send)
9001h Data too long (>1024byte)
9002h Data too short (Obyte)
9004h Character not allowed
3964R
Value Description
2000h Send ready without error
80FFh NAK received - error in communication
80FEh Data transfer without acknowledgement of partner or error
at acknowledgement
9000h Buffer overflow (no data send)
9001h Data too long (>1024byte)
9002h Data too short (Obyte)

5-10
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... Continue USS
RetVal SFC 217 Error code | Description
SER_SND 2000h | Send ready without error
8080h Receive buffer overflow (no space for receipt)

8090h Acknowledgement delay time exceeded
80FO0Oh Wrong checksum in respond

80FEh Wrong start sign in respond

80FFh Wrong slave address in respond

9000h Buffer overflow (no data send)

9001h Data too long (>1024byte)

9002h Data too short (<2byte)

Modbus RTU/ASCII Master

Error code |Description

2000h Send ready without error

2001h Send ready with error

8080h Receive buffer overflow (no space for receipt)
8090h Acknowledgement delay time exceeded
80FO0Oh Wrong checksum in respond

80FDh Length of respond too long

80FEh Wrong function code in respond

80FFh Wrong slave address in respond

9000h Buffer overflow (no data send)

9001h Data too long (>1024byte)

9002h Data too short (<2byte)
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Principles of
programming

The following text shortly illustrates the structure of programming a send

command for the different protocols.

3964R

SFC 217
SER_SND

J

N

RetVal 8xxxh |
90xxh ? -

N

Retval 2001h ? >J——
RetVal 2000h ? >J
N l

]

Error evaluation

Data evaluation

ASCII / STXIETX

SFC 217
SER_SND

RetVal 900xh J
NL Error evaluation

USS / Modbus

SFC 217
SER_SND

SFC 218
SER_RCV

Error evaluation

RetVal 2001h ? >J
N

RetVal 2000h ? >J

SFC 218
SER_RCV

Data evaluation

L]
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SFC 218 This block receives data via the serial interface.

(SER_RCV) Using the SFC 218 SER_RCYV after SER_SND with the protocols USS and
Modbus the acknowledgement telegram can be read.

Parameter

Name Declaration | Type Comment

DataPtr IN ANY Pointer to Data Buffer for received data

DataLen ouT WORD Length of received data

Error ouT WORD Error Number

RetVal ouT WORD Error Code (0 = OK)

DataPtr Here you set a range of the type Pointer for the receive buffer where the
reception data is stored. You have to set type, start and length.
Example: Data is stored in DB5 starting at 0.0 with a length of 124byte.

DataPtr:=P#DB5.DBX0.0 BYTE 124

DatalLen Word where the number of received Bytes is stored.
At STX/ETX and 3964R, the length of the received user data or O is
entered.
At ASCII, the number of read characters is entered. This value may be
different from the read telegram length.

Error This word gets an entry in case of an error. The following error messages
may be created depending on the protocol:
ASCII
Bit | Error Description

0 |overrun Overflow, a sign couldn’t be read fast enough from the
interface

1 |framing error |Error that shows that a defined bit frame is not
coincident, exceeds the allowed length or contains an
additional Bit sequence (Stopbit error)

2 | parity Parity error
3 |overflow Buffer is full
STX/ETX
Bit | Error Description
0 |overflow The received telegram exceeds the size of the receive
buffer.
1 |char A sign outside the range 20h...7Fh has been received.
3 |overflow Buffer is full

3964R / Modbus RTU/ASCII Master

Bit | Error Description
0 |overflow The received telegram exceeds the size of the receive
buffer.
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RetVal SFC 218 Return values of the block:
(Error message
SER_RCV) Error code |Description

0000h no error

1000h Receive buffer too small (data loss)

8x24h Error at SFC-Parameter x, with x:

1: Error at "DataPtr"

2: Error at "DataLen"

3: Error at "Error"

8122h Error in parameter "DataPtr" (e.g. DB too short)

809Ah Serial interface not found res. interface is used by
PROFIBUS

809Bh Serial interface not configured

Principles of The following picture shows the basic structure for programming a receive
programming command. This structure can be used for all protocols.

SFC 218
SER_RCV
RetVal 0000h ?

N

RetVal 8xo¢h ?

Data evaluation

Error evaluation
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Protocols and procedures

Overview

ASCII

STX/ETX

The CPU supports the following protocols and procedures:
» ASCIlI communication

o« STX/ETX

* 3964R

« USS

* Modbus

ASCII data communication is one of the simple forms of data exchange.
Incoming characters are transferred 1 to 1.

At ASCII, with every cycle the read-SFC is used to store the data that is in
the buffer at request time in a parameterized receive data block. If a
telegram is spread over various cycles, the data is overwritten. There is no
reception acknowledgement. The communication procedure has to be
controlled by the concerning user application. An according Receive_ASCI|
FB may be found within the VIPA library in the service area of www.vipa.de.

STX/ETX is a simple protocol with start and end ID, where STX stands for
Start of Text and ETX for End of Text.

The STX/ETX procedure is suitable for the transfer of ASCII characters. It
does not use block checks (BCC). Any data transferred from the periphery
must be preceded by a Start followed by the data characters and the end
character.

Depending of the byte width the following ASCIl characters can be
transferred: 5Bit: not allowed: 6Bit: 20...3Fh, 7Bit: 20...7Fh, 8Bit: 20...FFh.

The effective data, which includes all the characters between Start and End
are transferred to the PLC when the End has been received.

When data is send from the PLC to a peripheral device, any user data is
handed to the SFC 217 (SER_SND) and is transferred with added Start-
and End-ID to the communication partner.

Message structure:
STX1 — STX2 — 21 — 22 Zn — ETX1 — ETX2 —

—>ZVZ<—

You may define up to 2 Start- and End-IDs.

You may work with 1, 2 or no Start- and with 1, 2 or no End-ID. As Start-
res. End-ID all Hex values from 01h to 1Fh are permissible. Characters
above 1Fh are ignored. In the user data, characters below 20h are not
allowed and may cause errors. The number of Start- and End-IDs may be
different (1 Start, 2 End res. 2 Start, 1 End or other combinations). For not
used start and end characters you have to enter FFh in the hardware
configuration. If no End-ID is defined, all read characters are transferred to
the PLC after a parameterizable character delay time (Timeout).
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3964R The 3964R procedure controls the data transfer of a point-to-point link
between the CPU and a communication partner. The procedure adds
control characters to the message data during data transfer. These control
characters may be used by the communication partner to verify the
complete and error free receipt.

The procedure employs the following control characters:

« STX Start of Text

« DLE Data Link Escape

« ETX End of Text

« BCC Block Check Character
« NAK Negative Acknowledge

Procedure Active partner Passive partner

STX ~=—————P
Monitor delayed acknowledgment
<4—— DLE
Message-data —_—
DLE —Pp

ETX e
BCC ————

Monitor delayed acknowledgment

You may transfer a maximum of 255byte per message.

Note!

When a DLE is transferred as part of the information it is repeated to
distinguish between data characters and DLE control characters that are
used to establish and to terminate the connection (DLE duplication). The
DLE duplication is reversed in the receiving station.

The 3964R procedure requires that a lower priority is assigned to the
communication partner. When communication partners issue simultaneous
send commands, the station with the lower priority will delay its send
command.
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USS

Broadcast with set bit 5

in ADR-Byte

7 6 5 4 3 2

1

0

The USS protocol (Universelle serielle Schnittstelle = universal serial
interface) is a serial transfer protocol defined by Siemens for the drive and
system components. This allows to build-up a serial bus connection
between a superordinated master and several slave systems.

The USS protocol enables a time cyclic telegram traffic by presetting a fix
telegram length.

The following features characterize the USS protocol:

* Multi point connection

» Master-Slave access procedure

» Single-Master-System

* Max. 32 participants

» Simple and secure telegram frame

You may connect 1 master and max. 31 slaves at the bus where the single
slaves are addressed by the master via an address sign in the telegram.
The communication happens exclusively in half-duplex operation.

After a send command, the acknowledgement telegram must be read by a
call of the SFC 218 SER_RCV.

The telegrams for send and receive have the following structure:

Master-Slave telegram

[ [1] |

[
Broadcast

STX|LGE | ADR PKE IND PWE STW HSW BCC
02h HIL[IH]JLIHJL][H]JLJIHI[L
Slave-Master telegram
STX|LGE | ADR PKE IND PWE ZSW HIW BCC
02h HIL[IH]JLIHJL][H]JLJIHI[L
where STX: Start sign STW: Control word
LGE: Telegram length ZSW: State word
ADR: Address HSW: Main set value
PKE: Parameter ID HIW: Main effective value
IND: Index BCC: Block Check Character
PWE: Parameter value

A request can be directed to a certain slave ore be send to all slaves as
broadcast message. For the identification of a broadcast message you
have to set bit 5 to 1 in the ADR-Byte. Here the slave addr. (bit O ... 4) is
ignored. In opposite to a "normal" send command, the broadcast does not
require a telegram evaluation via SFC 218 SER_RCV. Only write
commands may be sent as broadcast.
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Modbus

Broadcast with
slave address = 0

ASCIIl, RTU mode

Supported Modbus
protocols

The Modbus protocol is a communication protocol that fixes a hierarchic
structure with one master and several slaves.

Physically, Modbus works with a serial half-duplex connection.

There are no bus conflicts occurring, because the master can only
communicate with one slave at a time. After a request from the master, this
waits for a preset delay time for an answer of the slave. During the delay
time, communication with other slaves is not possible.

After a send command, the acknowledgement telegram must be read by a
call of the SFC 218 SER_RCV.

The request telegrams send by the master and the respond telegrams of a
slave have the following structure:

Start Slave Function Data Flow End
sign address |Code control |sign

A request can be directed to a special slave or at all slaves as broadcast
message. To mark a broadcast message, the slave address 0 is used.

In opposite to a "normal" send command, the broadcast does not require a
telegram evaluation via SFC 218 SER_RCV.

Only write commands may be sent as broadcast.

Modbus offers 2 different transfer modes:

» ASCIlI mode: Every byte is transferred in the 2 sign ASCII code. The
data are marked with a start and an end sign. This causes a transparent
but slow transfer.

* RTU mode: Every byte is transferred as one character. This enables a
higher data pass through as the ASCIlI mode. Instead of start and end
sign, a time control is used.

The mode selection happens during runtime by using the SFC 216 SER_CFG.
The following Modbus Protocols are supported by the RS485 interface

¢« Modbus RTU Master
* Modbus ASCII Master

5-18
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Modbus - Function codes

Naming
convention

Range definitions

Modbus has some naming conventions:

Bit = IN: "Input Status"
Coil OUT: "Coil Status"

Word = | IN: "Input Register"
Register | OUT: "Holding Register"

Modbus differentiates between bit and word access;
Bits = "Coils" and Words = "Register".

Bit inputs are referred to as "Input-Status" and Bit outputs as "Coil-
Status".

Word inputs are referred to as "Input-Register" and Word outputs as
"Holding-Register".

Normally the access at Modbus happens by means of the ranges 0x, 1x, 3x
and 4x.

Ox and 1x gives you access to digital Bit areas and 3x and 4x to analog
word areas.

For the CPs from VIPA is not differentiating digital and analog data, the
following assignment is valid:

Ox:

1X:

3x:

4x:

ouT

Bit area for master output data
Access via function code 01h, 05h, OFh

Bit area for master input data
Access via function code 02h

Word area for master input data
Access via function code 04h

Word area for master output data
Access via function code 03h, 06h, 10h

1x0001

1x0002 1x0022
1x0003
HLNEEEEEEEEEEEE NN EEEEEEEEEE RN EEEREEEEN
3x0001 3x0002 3x0003
0x0001
0x0002 0x0022
0x0003
HLEEEEEEEEEEEEE EEEEREEEEEEEEEEE EEEEEEEEEEEEEEEN
4x0001 4x0002 4x0003

A description of the function codes follows below.
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Overview

Point of View of
"Input" and
"Output" data

With the following Modbus function codes a Modbus master can access a
Modbus slave: With the following Modbus function codes a Modbus master
can access a Modbus slave. The description always takes place from the
point of view of the master:

Code |Command
01h Read n Bits
02h Read n Bits
03h Read n Words
04h Read n Words
05h Write 1 Bit
06h Write 1 Word
OFh Write n Bits
10h Write n Words

Description

Read n Bits of master output area 0x
Read n Bits of master input area 1x
Read n Words of master output area 4x
Read n Words master input area 3x
Write 1 Bit to master output area 0x
Write 1 Word to master output area 4x
Write n Bits to master output area 0x
Write n Words to master output area 4x

The description always takes place from the point of view of the master.
Here data, which were sent from master to slave, up to their target are
designated as "output" data (OUT) and contrary slave data received by the
master were designated as "input" data (IN).

System 200V - Slave Periphery
PtP ‘ CPU
System 300S - Master
CPU PtP ouT
write (05h,0F :bit, 06h10h:word) > Ox(bit) » RECEIVE FC1 ouT » ouT
ouT read (01h:bit, 03h:word) 4x(word)
IN
IN read (02h:bit, 04h:word) 1x(bit) < SEND FCO IN €—— IN
3x(wort)

Respond of the
slave

Byte sequence
in a Word

Check sum CRC,
RTU, LRC

If the slave announces an error, the function code is send back with an
"ORed" 80h. Without an error, the function code is sent back.

Function code OR 80h
Function code

= Error
- OK

Slave answer:

1 Word

High Low
Byte Byte

For the Byte sequence in a Word is always valid:

The shown check sums CRC at RTU and LRC at ASCIl mode are
automatically added to every telegram. They are not shown in the data
block.
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Read n Bits
01h, 02h

Code 01h: Read n Bits of master output area 0x
Code 02h: Read n Bits of master input area 1x

Command telegram

Slave address | Function code Address Number of Check sum
1. Bit Bits CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
Respond telegram
Slave address | Function code Number of Data Data Check sum
read Bytes 1. Byte 2. Byte CRC/LRC
1Byte 1Byte 1Byte 1Byte 1Byte 1Word
max. 250Byte
Read n Words 03h: Read n Words of master output area 4x
03h, 04h 04h: Read n Words master input area 3x
Command telegram
Slave address | Function code Address Number of Check sum
1. Bit Words CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
Respond telegram
Slave address | Function code Number of Data Data Check sum
read Bytes 1. Word 2. Word CRC/LRC
1Byte 1Byte 1Byte 1Word 1Word 1Word
max. 125 Words
Write 1 Bit Code 05h: Write 1 Bit to master output area Ox
05h A status change is via "Status Bit" with following values:
"Status Bit" = 0000h - Bit=0
"Status Bit" = FFOOh - Bit =1
Command telegram
Slave address Function Address Status Check sum
code Bit Bit CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
Respond telegram
Slave address Function Address Status Check sum
code Bit Bit CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
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Write 1 Word

06h

Code 06h: Write 1 Word to master output area 4x

Command telegram

Write n Bits OFh

Command telegram

Code OFh: Write n Bits to master output area 0x
Please regard that the number of Bits has additionally to be set in Byte.

Slave address Function Address Value Check sum
code word word CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
Respond telegram
Slave address Function Address Value Check sum
code word word CRC/LRC
1Byte 1Byte 1Word 1Word 1Word

Slave address | Function Address Number of Number of Data Data Check sum
code 1. Bit Bits Bytes 1.Byte | 2. Byte CRC/LRC
1Byte 1Byte 1Word 1Word 1Byte 1Byte 1Byte 1Byte 1Word
max. 250 Byte
Respond telegram
Slave address | Function Address Number of | Check sum
code 1. Bit Bits CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
Write n Words 10h  Code 10h: Write n Words to master output area 4x
Command telegram
Slave address | Function Address Number of Number of Data Data Check sum
code 1. Word words Bytes 1. Word | 2. Word CRC/LRC
1Byte 1Byte 1Word 1Word 1Byte 1Word 1Word 1Word 1Word
max. 125 Words
Respond telegram
Slave address | Function | Address Number of Check sum
code 1. Word Words CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
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Modbus - Example communication

Overview The example establishes a communication between a master and a slave
via Modbus. The following combination options are shown:

Modbus master (M) Modbus slave (S)
CPU 31xS

CPU 21xSER-1

Components The following components are required for this example:

CPU 31xS as Modbus RTU master

CPU 21xSER-1 as Modbus RTU slave

Siemens SIMATIC Manager and possibilities for the project transfer

Approach .

Modbus cable connection

Assemble a Modbus system consisting of a CPU 31xS as Modbus
master and a CPU 21xSER-1 as Modbus slave and Modbus cable.

Execute the project engineering of the master!
For this you create a PLC user application with the following structure:

OB 100:

OB 1:

Call SFC 216 (configuration as Modbus RTU master) with
timeout setting and error evaluation.

Call SFC 217 (SER_SND) where the data is send with error
evaluation. Here you have to build up the telegram according
to the Modbus rules.

Call SFC 218 (SER_RECV) where the data is received with
error evaluation.

Execute the project engineering of the slave!
The PLC user application at the slave has the following structure:

OB 100:

OB 1:

Call SFC 216 (configuration as Modbus RTU slave) with
timeout setting and Modbus address in the DB and error
evaluation.

Call SFC 217 (SER_SND) for data transport from the slave
CPU to the output buffer.

Call SFC 218 (SER_RECV) for the data transport from the
input buffer to the CPU. Allow an according error evaluation
for both directions.

The following page shows the structure for the according PLC programs for
master and slave.
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Master

CPU 31xS

‘ Master

Slave

CPU 21xSER-1
CPU

Slave ‘

— SER_RCV

L —» RetVal

<— SER_SND

CPU
| SER SND | code/data
|
- SERRcV. < RetVal —
]
l
\ code !
| SER_SND | '
]
| SER RCV @ —

0OB100:

SFC 216
SER_CFG

L —» RetVal

SFC 216

SER_CFG

(DB: Timeout)

(DB: Timeout, slave address)

OB1: le

N

SFC 217
SER_SND

(mit Slave-Nr., Code,

Bereich)

RetVal 700xh?
N RetVal 9001h 2>>J
N
etVal 8xxxh - ¢

N RetVal 0000h ? >J—
N
L

RetVal 2001h ? >-J———

N
RetVal 2000h ? 3
N N
RetVal 0000h ? >J
J “

N- Data evaluation

N
J
:

it

SFC 217
SER_SND

SFC 218
SER_RCV

SFC 218
SER_RCV

SER_SND
RetVal 2001h

RetVal 8xxxh ?
N
L

L
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Chapter 6 Deployment PROFIBUS communication

Overview Content of this chapter is the deployment of the CPU 314-2BG03 with
PROFIBUS. After a short overview the project engineering and
parameterization of the PROFIBUS DP slave of the CPU 314-2BG03 from
VIPA is shown.

Both the project engineering of the DP slave and the integration in a DP
master system are shown.

The chapter is ended with notes to the PROFIBUS installation guidelines.

Content Topic Page
Chapter 6  Deployment PROFIBUS communication ....................... 6-1

L@ = = 6-2

Deployment as PROFIBUS DP slave ...........cccooviiiiiiiiiiiiciie e, 6-3

PROFIBUS installation guidelines ............cccouviiiiiiiiiiiiiiiiiiecee s 6-5
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Overview

PROFIBUS DP

DP slave operation

Firmware update

On delivery

Behavior at
CPU STOP

PROFIBUS is an international standard applicable to an open and serial
field bus for building, manufacturing and process automation that can be
used to create a low (sensor-/actuator level) or medium (process level)
performance network of programmable logic controllers.

PROFIBUS comprises an assortment of compatible versions. The following
details refer to PROFIBUS DP.

PROFIBUS DP is a special protocol intended mainly for automation tasks
in a manufacturing environment. DP is very fast, offers Plug'n'Play facilities
and provides a cost-effective alternative to parallel cabling between PLC
and remote I/O. PROFIBUS DP was designed for high-speed data commu-
nication on the sensor-actuator level.

The data transfer referred to as "Data Exchange" is cyclical. During one
bus cycle, the master reads input values from the slaves and writes output
information to the slave.

For the deployment in a super-ordinated master system you first have to
project your slave system as CPU 315-2DP (6ES7 315-2AG10-0AB0/V2.6)
in Slave operation with configured in-/output areas. Afterwards you
configure your master system. Assign your slave system to your master
system by dragging the SPEED7-CPU from the hardware catalog at
Configured stations onto the master system, choose your slave system and
connect it.

Now by means of Properties at Configuration assign via double click to the
according configuration line the according input address area on the
master CPU to the slave output data and the output address area to the
slave input data.

The firmware update of the integrated PROFIBUS part happens
automatically by the firmware update of the CPU.

On delivery the CPU is overall reset. The PROFIBUS part is deactivated
after PowerON.

With every change of the RUN STOP state of the CPU, the DP slave sends
a diagnostics telegram to the subordinated DP master. Independent on the
CPU state the DP slave remains in data exchange.

6-2
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Deployment as PROFIBUS DP slave

Fast introduction In the following the deployment of the PROFIBUS section as "intelligent"
DP slave on master system is described, which exclusively may be
configured in the Siemens SIMATIC manager.

The following steps are required:

Project .
engineering of the
slave section .

Configure a station with a CPU with operating mode DP slave.

Connect to PROFIBUS and configure the in-/output area for the slave
section.

Save and compile your project.

Configure another station with another CPU with operating mode DP
master.

Connect to PROFIBUS and configure the in-/output ranges for the
master section

Save, compile and transfer your project to your CPU.

Start the Siemens SIMATIC manager and configure a CPU as described
at "Hardware configuration - CPU".

Designate the station as "...DP slave"
Add your modules according to the real hardware assembly.

Open the properties dialog of the DP interface of the CPU by means of
a double-click at DP.

Set Interface type to "PROFIBUS"

Connect to PROFIBUS and preset an address (preferably 3) and
confirm with [OK].

Switch at Operating mode to "DP slave"

Via Configuration you define the in-/output address area of the slave
CPU, which are to be assigned to the DP slave.

Save, compile and transfer your project to your CPU.

Slave section

Standard kl)\/lljsd | Object properties

S|10t odue Operating mode: DP slave
> CPU Connect: PROFIBUS

X2 DP PROFIBUS address: > 1
3 Configuration:

4 Input area

Output area

5 | Modules P

HB140E - CPU - RE_314-2BG03 - Rev. 12/06 6-3



Chapter 6 Deployment PROFIBUS communication Manual VIPA System 300S SPEED7

Project
engineering of the
master section

Master section

Insert another station and configure a CPU.
Designate the station as "...DP-Master".
Add your modules according to the real hardware assembly.

Open the properties dialog of the MPI/DP interface of the CPU by
means of a double-click at MPI/DP.

Set Interface: type to "PROFIBUS"

Connect to PROFIBUS and preset an address (preferably 2) and
confirm with [OK].

Switch at Operating mode to "DP master" and confirm the dialog with
[OK].

Connect your slave system to this master system by dragging the
"CPU 31x" from the hardware catalog at Configured stations onto the
master system and select your slave system to be coupled.

Open the Configuration at Object properties of your slave system.

Via double click to the according configuration line you assign the
according input address area on the master CPU to the slave output
data and the output address area to the slave input data.

Save, compile and transfer your project to your CPU.

Standard bus

Slot Module
1
2 CPU ...
X2 = DP PROFIBUS DP master system
3
)
IL Modules S7-300 @
6 Hardware catalog: CPU 31x from
i 3 configured stations
v +®
Object properties Object properties
Operating mode: DP master Configuration:
Connect: PROFIBUS Input area slave CPU = Output area master-CPU

PROFIBUS address: > 1 Output area slave CPU = Input area Master-CPU

6-4
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PROFIBUS installation guidelines

PROFIBUS in
general

Transfer medium

* A PROFIBUS DP network may only be built up in linear structure.

« PROFIBUS DP consists of minimum one segment with at least one
master and one slave.

» A master has always been deployed together with a CPU.
» PROFIBUS supports max. 126 participants.

» Per segment a max. of 32 participants is permitted.

* The max. segment length depends on the baud rate:

9.6 ... 187.5kbaud - 1000m
500kbaud - 400m
1.5Mbaud - 200m
3 ... 12Mbaud - 100m

* Max. 10 segments may be built up. The segments are connected via
repeaters. Every repeater counts for one participant.

» The bus respectively a segment is to be terminated at both ends.

» All participants are communicating with the same baud rate. The slaves
adjust themselves automatically on the baud rate.

As transfer medium PROFIBUS uses an isolated twisted-pair cable based
upon the RS485 interface.

The RS485 interface is working with voltage differences. Though it is less
irritable from influences than a voltage or a current interface. You are able
to configure the network as well linear as in a tree structure.

Max. 32 participants per segment are permitted. Within a segment the
members are linear connected. The segments are connected via
repeaters. The maximum segment length depends on the transfer rate.

PROFIBUS DP uses a transfer rate between 9.6kbaud and 12Mbaud, the
slaves are following automatically. All participants are communicating with
the same transfer rate.

The bus structure under RS485 allows an easy connection res.
disconnection of stations as well as starting the system step by step. Later
expansions don’'t have any influence on stations that are already
integrated. The system realizes automatically if one partner had a fail down
or is new in the network.
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Bus connection

Master

The following picture illustrates the terminating resistors of the respective
start and end station.

RxD/TXxD-P(B) 3

Slave Slave
6 N N 6
P5V - |- -, [ [ - ¢ - P5V
o [ P o
1 1

Posso | [ 330,
L‘,‘ | \ | \ Lo

| | |

| ! 3 RxD/TxD-P(B) 3 ' | 13 RxDTxD-P(B)

o \
| l
RxD/TxD-N(A) 8 Iy | ‘ 8 RxD/TxD-N(A) 8 ‘ 1~ |8 RxD/TxD-N(A)
e I J i
(. | I I (.
| 1330 ! ! 330,
[ 1 J J [
5| 1~ | | X R
M5V — @ — \ I \ | ‘-¢ - M5V
| |
\ I | I
\ i \ I
sos | Vool s |\ ] s

EasyConn
bus connector

Note!

The PROFIBUS line has to be terminated with its ripple resistor. Please
make sure to terminate the last participants on the bus at both ends by
activating the terminating resistor.

In PROFIBUS all participants are wired parallel. For that purpose, the bus
cable must be feed-through.
Via the order number VIPA 972-0DP10 you may order the bus connector
"EasyConn". This is a bus connector with switchable terminating resistor
and integrated bus diagnostic.

0° 45° 90°

a o
é = &l
| 1)
A A Al
E 0 O o E
B B B c
0° 45° 90°
A 64 61 66
B 34 53 40
C 15.8 15.8 15.8
all in mm
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Termination with
"EasyConn"

Wiring
1./last
bus participant

Assembly

Please note:

Note!

To connect this EasyConn plug, please use the standard PROFIBUS cable
type A (EN50170). Starting with release 5 you also can use highly flexible
bus cable: Lapp Kabel order no.: 2170222, 2170822, 2170322.

With the order no. 905-6AA00 VIPA offers the "EasyStrip" de-isolating tool
that makes the connection of the EasyConn much easier.

Dimensions in mm

The "EasyConn" bus connector is provided with a switch that is used to
activate a terminating resistor.

further Attention!

participants The terminating resistor is only
effective, if the connector is installed at
a bus participant and the bus participant
is connected to a power supply.

Note!

A complete description of installation
and deployment of the terminating
resistors is delivered with the connector.

* Loosen the screw.

» Lift contact-cover.

* Insert both wires into the ducts
provided (watch for the correct
line color as below!)

* Please take care not to cause a
short circuit between screen and
data lines!

» Close the contact cover.

» Tighten screw
(max. tightening torque 4Nm).

The green line must be connected to A, the red line to B!
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Chapter 7 WinPLC7

Outline In this chapter the programming and simulation software WinPLC7 from
VIPA is presented. WIinPLC7 is suited for every with Siemens STEP®7
programmable PLC.

Besides the system presentation and installation here the basics for using
the software is explained with a sample project.

More information concerning the usage of WinPLC7 may be found in the
online help respectively in the online documentation of WinPLC?7.

Content Topic Page
Chapter 7 WINPLCT ... 7-1

System presentation...........oo i 7-2

INSEAIALION ... 7-3

Example project engineering ............oooooiiiiiiiiiiiiii e 7-4
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System presentation

General WiInPLC7 is a programming and simulation software from VIPA for every
PLC programmable with Siemens STEP®7.
This tool allows you to create user applications in FBD, LAD and STL.
Besides of a comfortable programming environment, WinPLC7 has an

integrated simulator that enables the simulation of your user application at
the PC without additional hardware.

This “Soft-PLC” is handled like a real PLC and offers the same error
behavior and diagnosis options via diagnosis buffer, USTACK and
BSTACK.

Note!

Detailed information and programming samples may be found at the online
help respectively in the online documentation of WinPLC?7.

Alternatives There is also the possibility to use the Siemens SIMATIC manager instead
of WinPLC7 from VIPA. Here the proceeding is part of this manual.

System * Pentium with 233MHz and 64Mbyte work space
requirements « Graphics card with at least 16bit color - we recommend a screen
resolution of at least 1024x768 pixel.

» Windows 98SE/ME, Windows 2000,
Windows XP (Home and Professional), Windows Vista

Source You may receive a demo version from VIPA. Without any activation with
the demo version the CPUs 11x of the System 100V from VIPA may be
configured.

To configure the SPEED7 CPUs a license for the "profi" version is
necessary. This may be online received and activated.

There are the following sources to get WinPLC7:

Online At www.vipa.de in the service area at Downloads a link to the current demo
version and the updates of WinPLC7 may be found.

CD Order no. Description

SW211C1DD |WinPLC7 Single license, CD, with documentation in german

SW211C1ED |WinPLC?7 Single license, CD, with documentation in english

SW900TOLA | ToolDemo
VIPA software library free of charge respectively demo
versions, which may be activated
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Installation

Preconditions

Installation
WinPLC7
Demo

Activation of the
"Profi" version

Installation of
WinPCAP for
station search via
Ethernet

The project engineering of a SPEED7 CPU from VIPA with WinPLC7 is
only possible using an activated "Profi" version of WinPLC7.

The installation and the registration of WinPLC7 has the following
approach:

For installation of WinPLC7 start the setup program of the
corresponding CD respectively execute the online received exe file.

Choose the according language.
Agree to the software license contract.

Set an installation directory and a group assignment and start the
installation.

Start WinPLC7. A "Demo" dialog is shown.
Click at [Activate Software]. The following dialog for activation is shown:

Serial number (34-digit). |
System number: 5YS-1888PLETVS

Activating key:

Get acivation key online (via intemet)

Install dhive=C:\PROGRAMME \MHJ-SOF TWARENWNSPS-S 745,

Fill in the following fields:
Email-Addr., Your Name und Serial number. The serial number may be
found on a label at the CD case.

If your computer is connected to Internet you may online request the
Activation Key by [Get activation key via Internet]. Otherwise click at
[This PC has no access to the internet] and follow the instructions.

With successful registration the activation key is listed in the dialog
window respectively is sent by email.

Enter the activation key and click to [OK]. Now, WinPLC?7 is activated as
"Profi" version.

To find a station via Ethernet (accessible nodes) you have to install the
WiInPCAP driver. This driver may be found on your PC in the installation
directory at WinSPS-S7-V5/WinPcap_... .exe.

Execute this file and follow the instructions.
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Example project engineering

Job definition

Here it should
apply:

Precondition

Project
engineering

Hardware
configuration

In the example a FC 1 is programmed, which is cyclically called by the
OB 1. By setting of 2 comparison values (valuel and value2) during the FC
call, an output of the PLC-System should be activated depending on the
comparison result.

if valuel = value2 activate output Q 124.0
if valuel > value2 activate output Q 124.1
if valuel < value2 activate output Q 124.2

* You have administrator rights for your PC.
* WinPLC7 is installed and activated as "Profi" version.
* One CPU and one digital output module are installed and cabled.

» The Ethernet PG/OP channel of the CPU is connected to your Ethernet
network. Your CPU may be connected to your PC with an Ethernet
cable either directly or via hub/switch.

» WinPCap for station search via Ethernet is installed.

» The power supply of the CPU and the I/O periphery are activated and
the CPU is in STOP state.

o Start WinPLC7 ("Profi" version)
» Create and open a new project with [Create a new solution].

» For the call of the hardware configurator it is necessary to set WinPLC7
from the Simulator-Mode to the Offline-Mode. For this and the communi-
cation via Ethernet set "Target: TCP/IP Direct".

File Edit Block PLC  Wiew Extras Help
SHRbAARH S EAEEEE 2 E K
| Editproject Y B
0G-22072011-164430-ENG.WS7 (Solut i

EEEEEE

151

mlu]=] |

RIS -

* Enter a station name. Please consider that the name does not contain
any spaces.

» After the load animation choose in the register Select PLC-System the
system "VIPA SPEED7" and click to [Create]. A new station is created.

» Save the empty station.

» By double click or drag&drop the according VIPA CPU in the hardware
catalog at CPU SPEED?7 the CPU is inserted to your configuration.

» For output place a digital output module and assign the start address 124.
» Save the hardware configuration.

7-4
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Online access via
Ethernet PG/OP
channel

Transfer hardware
configuration

Open the CPU-Properties, by double clicking to the CPU at slot 2 in the
hardware configurator.

Click to the button [Ethernet CP-Properties (PG/OP-channel)]. The
Properties CP343 is opened.

Chose the register Common Options.
Click to [Properties Ethernet].
Choose the subnet "PG_OP_Ethernet".

Enter a valid IP address-and a subnet mask. You may get this from your
system administrator.

Close every dialog window with [OK].
Select, if not already done, "Target: External TCP/IP direct".

Open with Online > Send configuration to the CPU a dialog with the
same name.

Click to [Accessible nodes]. Please regard to use this function it is
necessary to install WinPCap before!

Choose your network card and click to [Determining accessible nodes].
After a waiting time every accessible station is listed. Here your CPU
with IP 0.0.0.0 is listed, too. To check this the according MAC address is
also listed. This MAC address may be found at a label beneath the front
flap of the CPU.

For the temporary setting of an IP address select you CPU and click to
[Temporary setting of the IP parameters]. Please enter the same IP
parameters, you configured in the CPU properties and click to [Write
Parameters].

Confirm the message concerning the overall reset of the CPU. The IP
parameters are transferred to the CPU and the list of accessible stations
is refreshed.

Select you CPU and click to [Confirm]. Now you are back in the dialog
"Send configuration".

Choose your network card and click to [Send configuration]. After a
short time a message is displayed concerning the transfer of the
configuration is finished.

Note!

Usually the online transfer of the hardware configuration happens within
the hardware configurator.

With File > Save active station in the WIinPL7 sub project there is also the
possibility to store the hardware configuration as a system file in WinPLC7
to transfer it from WinPLC7 to the CPU.

The hardware configuration is finished, now and the CPU may always be
accessed by the IP parameters as well by means of WinPLC?7.
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Programming of The PLC programming happens by WinPLC7. Close the hardware
the FC 1 configurator and return to your project in WinPLC7.

The PLC program is to be created in the FC 1.

Creating block FC 1« In "Project content" choose New > FC.

Ei < Extras Help
SHAEANRMS § BAAEEE 6w & FART
o B I

£ prcgect £ Prommt conbent
G221

¥t Babona +00 1 sndactnd ocks ko the P
o ce

» Enter "FC1" as block and confirm with [OK]. The editor for FC 1 is

called.
Creating In the upper part of the editor there is the parameter table. In this example
parameters the 2 integer values valuel und value2 are to be compared together. Since

both values are read only by the function, these are to be defined as "in".

* Select the "in -->" row at the parameter table and enter at the field
Name "value1". Press the [Return] key. The cursor jumps to the column
with the data type.

» The data type may either directly be entered or be selected from a list of
available data types by pressing the [Return] key. Set the data type to
INT and press the [Return] key. Now the cursor jumps to the Comment
column.

» Here enter "1. compare value" and press the [Return] key. A new "in -->"
row is created and the cursor jumps to Name.

* Proceed for value2 in the same way as described for valuel.

» Save the block. A note that the interface of the block was changed may
be acknowledged with [Yes].

The parameter table shows the following entries, now:
-+~ |

= i @ @ 3% ‘B = 8 Load FCl into the PLC ¥ Synchronize 69" Monitoring On/off M etwark 1
bll == ¢ Addiess | Declaration Mame Tupe Initial value Comment
0.0 _ waluel INT 1. compare value
20 walue? INT 2. compare value
out <=

30-ENGFRI 5 B

in_out &=
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Enter the program

As requested in the job definition, the corresponding output is activated
depending on the comparison of valuel and value2. For each comparison
operation a separate network is to be created.

The program is to be created as FBD (function block diagram). Here
change to the FBD view by clicking at FBD.

LAD By |[Fetwork 1 ¥ Network ticle=

Network comment=

<empty

Click to the input field designated as "<empty>".

The available operations may be added to your project by drag&drop
from the hardware catalog or by double click at them in the hardware
catalog.

Open in the catalog the category "Comparator" and add the operation
"CMP==I" to your network.

File Edit Black PLC Wiew Extras Help
Sanfdaand S EA-FEEE s = &eno 0 FMRER T Towet S
o SR
2 it logic £
% 5 E?% am, I A 5B g4 T oL =[] 2 {8] @ = 58 LoadFctintathe PLC T Synchronize &
-E >] CMP ==l il == = pddress Declaration MName Type Initial va
g >] P ol b 0.0 R valel INT
5 7] EMP o 20 value2 INT
& g 3] oMP £ — =
% Bl CHP >4 & In_out &=
5 >] oM<l & — =
— g
e e
‘% ] CHP 2D & Block coument=
[ >] CMP<D i
s 3] CMP2=D g
I3 >] CMP <=D 8
= »] CMP ==R & STL LAD 8y |Network 1 ¥ MHerwork titles
& >] CMP o | - e
= >] CMP 3R . o e e
>| CMP <R R
1 CMP <R | B R e e e
>] CMP <=R Ciiarayrwry — R llioiiiiiiiiiiiiiiiiiiiiiiin
B | & L] Conveter o [
8 -[+1] Counter 3::3??(INTJ_' o sy e oy i s e i
- [08] DB-Cal ;
w2l domns o

Click to the input left above and insert valuel. Since these are block
parameters a selection list of block parameters may be viewed by
entering "#".

Type in "#" and press the [Return] key.

Choose the corresponding parameter and confirm it with the [Return]
key.

Proceed in the same way with the parameter value2.
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Adding a new
network

The allocation to the corresponding output, here Q 124.0, takes place with
the following proceeding:

» Click to the output at the right side of the operator.

» Open in the catalog the category "Bit logic" and select the function
"--[=]". The inserting of "--=" corresponds to the WinPLC7 shortcut [F7].

* Insert the output Q 124.0 by clicking to the operand.

Network1 is finished, now.

For further comparisons the operations "CMP>I" at Q 124.1 and "CMP<|"
at Q 124.2 are necessary. Create a network for both operations with the
following proceeding:

* Move your mouse at an arbitrary position on the editor window and
press the right mouse key.

» Select at the context menu "Insert new network". A dialog field is
opened to enter the position and number of the networks. Or click at
[Add a network at the end of the block].

* Proceed as described for "Network 1".

» Save the FC 1 with File > Save content of focused window respectively
press [Strg]+[S].

7-8
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FC1 After you have programmed the still missing networks, the FC 1 has the
following structure:

m=  s7n [FED] i B By B 0

Network comment=

CHFP

$raluel — "L

0lz4._0
Frale? e ot p— e

m= 7L [FBD]  LaD By B

Network comment=

CHFP

fraluel —— =T

Qlz4.1

Frralie? e e

m= 7L [FED]  LaD By B0

Network comment=

CHFP

fralual — =I

Qlz4 2
Fralue?l e . =
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Creating the block  The FC 1 is to be called from the cycle OB 1.
OB 1 + Go to OB 1, which was automatically created with starting the project.

» Go to "Project content" or to "Solution" and open the OB 1 by a double
click.

» Change to the STL view.

» Type in "Call FC 1" and press the [Return] key. The FC parameters are
automatically displayed and the following parameters are assigned:

"Cyoclic main program"

EBlock comment=

== [STL] FED L&D 3y |Network 1 X ome

Network comments=

o CALL FC 1-
1 valuel:=10

Z valuez:=10

3

» Save the OB 1 with H or [Strg]+[S].

Test the PLC With WinPLC7 there is the possibility to test your project in a simulator.
program in the « Here select "Target: Simulator".
Simulator Fie Edt Bock PLC view Extras Help

LahBHdane & E-8EEFE -k
 Edit project: i . '-E__Pm]e:t content

c [PROG-22072011-164430-ENG.WST (Solut 5
S |57-PROG-22072011-164430-ENG

Lo open ¥ hew... Refresh [l Load selected blocks into the PLC all blacks inta the PLC

AanAastEy alendue]

:;‘ -l Blocks o

=it OB = oG
Gl TR e I o are |
B o1 = O st STLFBD-LAD  nb 2 108 - nb
e | o FE % Ot fFot STLFED-LAD  mh 16 106 - b
N | ® e o 0@ svMBOLTABLE 5EQ Symbolic table

» Transfer the blocks to the simulator with [Load all blocks into the PLC].

1B E D X e G s F M [E] T Tawet Simulaior v

- EEPruiect conkent

3 Open ¥ Hew... Refresh [l Load selected blocks intothe PLC £T¥ Synchranize CTRLHY ¥ Load all blacks inta the PLC  Reset filter

O ost ] - -l b 1725132445056 20117-25 | 13.24.45(56)
[ 1.0 STLFBDLAD mh 16 108 < onb N\ nb 2011722|17:49:29(32) 2011722 |18:16:55(32)
&  SYMBOLTABLE.SEQ 5 ymbolic: table -

[0 H#  VARISBLETABELLEVAR StatusVariable

» Switch the CPU to RUN, by clicking at RUN in the "CPU Control Center"
of "Edit project". The displayed state changes from STOP to RUN.

» To view the process image select View > Display process image
window or click at '=!=l. The various areas are displayed.

» Double click to the process image and enter at "Line 2" the address
PQB 124. Confirm with [OK]. A value marked by red color corresponds
to a logical "1".

* Openthe OB 1.

» Change the value of one variable, save the OB 1 and transfer it to the
simulator. According to your settings the process image changes
immediately. The status of your blocks may be displayed with Block >
Monitoring On/Off.
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Visualization via
PLC mask

Transfer PLC
program to CPU
and its execution

A further component of the simulator is the PLC mask. Here a CPU is
graphically displayed, which may be expanded by digital and analog
peripheral modules.

As soon as the CPU of the simulator is switched to RUN state, inputs may
be activated by mouse and outputs may be displayed.

Open the PLC mask with view > PLC mask. A CPU is graphically
displayed.

Double-click to the output module, open its properties dialog and enter
the Module address 124.

Switch the operating mode switch to RUN by means of the mouse. Your
program is executed and displayed in the simulator, now.

AL e PP

LR Ty
ERBAAARS S FoH-AHEE N S E T T e e .=
[ U T—
1 081 it . O Schvenin. R Wskinng CoCIT
Tor LT

[T -
_— I AT TABE
~ Irkusral ueftvrars PLC. i
= i m &
F 1w '
4 a0 ir
b 1 pos
nc i
HE 3 -
g 2 -
. '

For transfer to the CPU set the transfer mode to "Target: TCP/IP-
Direct".

If there are more network adapters in your PC, the network adapter may
be selected via Extras > Select network adapter.

For presetting the Ethernet data click to [...] and click to
[Accessible nodes].

memary
- nb nb 2011-7-25 | 13:24:45(5E) 2011-7-25 |12
STLFEDLAD  mh 16 106 - nb nb 20011-7-22 | 17:49:29(32) 2011-7-22 | 1%

430-ENGPR) £ T

(@  SMBOLTABLESEQ Symblic table

Click at [Determining accessible nodes]. After a waiting time every
accessible station is listed.

Choose your CPU, which was provided with TCP/IP address parameters
during the hardware configuration and click to [Confirm].

Close the "Ethernet properties" dialog with [OK].

Transfer your project to your CPU with PLC > Send all blocks.
Switch your CPU to RUN state.

Open the OB 1 by double click.

Change the value of one variable, save the OB 1 and transfer it to the
CPU. According to your settings the process image changes imme-
diately. The status of your blocks may be displayed with Block >
Monitoring On/Off.
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